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Chapter 1 – Introduction
About T4 TimeSaver
ELM Computer Systems Inc. has provided custom programming and consulting
services to accounting firms and to small business since 1978. Its team of
experienced programmers and analysts has thoroughly analyzed your needs as a
professional accountant, and is committed to providing and maintaining a tax slip
preparation system which is superior to any other system available.

Technical Support
As a registered user you may telephone or fax us with your questions about the
installation and use of the T4 TimeSaver program. Our technical support hours
are 9am to 5pm ET.
Technical Support Hot Line:
Local to Toronto:
Fax Number:
Email:
Product Website:
Corporate Website:

1-800-268-3211
(416) 495-1624
(416) 495-0044
support@t4timesaver.ca
www.t4timesaver.ca
www.elmcomputers.com

If you encounter a problem with the software, you may find some assistance in
the "Common Problems" listed in Appendix C of this User Manual or in the
program's on-line help system under the title "Common Problems". To access
this information, press [F1] anywhere in the program and click the Contents tab
to view the table of contents for the Help system.
Technical support is available in the French language at our Montreal office.
(Support from our Toronto office is available only in English).
French Language Technical Support:
Telephone number:
Fax Number:

(450) 441-6605
(450) 441-9937

Requesting System Enhancements
We value your suggestions at ELM Computer Systems Inc. and attempt, as
much as possible to incorporate them into future versions of T4 TimeSaver.
Many of the features now available in the system are the result of comments
made by people such as yourself who have used the program for years.
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If there is a feature which you would like to see in T4 TimeSaver please call or
send us a note and let us know. We cannot promise that all suggestions will be
incorporated into the system but we assure you that each one will be given our
careful consideration.
Thank you in advance for helping us to make T4 TimeSaver the finest tax slip
preparation software available in Canada.

Hardware Requirements
Computer
Any Pentium class PC
Operating System
Windows95 (no longer supported by Microsoft), Windows 98 , Windows
ME, Windows NT, Windows 2000, Windows XP, Windows 2003

1

System Memory
A minimum of 32 Mb RAM is required to run T4 TimeSaver. Typically, any system
able to run a current version of Windows will be able to run T4 TimeSaver.
Disk Drives
A hard disk drive with at least 10 Mb of available disk space is required for
installation of the program files while leaving sufficient space for data. For
optimal performance of both T4 TimeSaver and other software ensure that you
have sufficient room available on your hard disk for the virtual memory swap file
maintained by Windows. Typically this file is 50% greater than the size of the
available RAM installed on your system. Data may be stored on either a hard
disk or on removable media; T4 TimeSaver performs much better if data is stored
on a hard disk. The system and/or its data files may also be installed on a
network file server.
Printer
Slips and summaries may be printed on ink jet and laser printers using
government supplied forms. T4 TimeSaver will not print to dot-matrix (or impact)
printers as these forms are no longer supported by either the CRA or the MRQ.
T4 TimeSaver can also produce most forms as facsimiles on ink jet and laser
printers. You may also produce most types of returns on diskette, CD or DVD,
greatly reducing your paper requirements and the labour involved in producing
these returns.
1

Note: Windows is a registered trademark of Microsoft Corporation. All product
names mentioned in this manual and not listed are trademarks of their respective
companies.
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License Agreement
T4 TimeSaver ("program") is owned by ELM Computer Systems. ELM Computer
Systems hereby grants to you a non-exclusive, non-transferable license to use
the program. You are expressly prohibited from distribution of the program to
others outside your office, regardless of whether such distribution is for profit. All
rights, title and interest in and to the program, and all documentation, code and
logic which describes and/or comprises the program is vested in ELM Computer
Systems. Your right to use the program is conditional upon and limited by the
terms and conditions of this license. You may not: (a) modify, adapt, translate,
reverse engineer, decompile, disassemble, or create derivative works based on
the program; or (b) loan, rent, lease or sublicense the program or any copy,
without the prior written consent of ELM. Any violation of these provisions will
constitute an automatic revocation of your license to use the program and will
subject you to substantial liability under the applicable legislation of the
jurisdiction in which the program is being used.
You are permitted to use the program on any and all personal computers in your
office, with no restriction on the number of concurrent users. Use of the program
at other offices (i.e. different street addresses) is prohibited unless separate
licenses have been purchased for each office.

Warranty Information
We warrant to you for ninety (90) days from the date you received the software
package that the package contains an accurate reproduction of the program, and
the copy of the User Manual is accurately reproduced. The program itself is
excluded from our warranty. To obtain replacement of these materials, you must
(i) return the inaccurate package or copy of the User Manual to us within the
warranty period, or (ii) first notify us in writing within the warranty period that you
have found an inaccuracy and then return the materials to us. This limited
warranty only covers the original user of the software package, and we make no
other warranties expressed or implied. ANY AND ALL WARRANTIES
RELATING HERETO ARE LIMITED IN DURATION TO THIS NINETY-DAY
WARRANTY PERIOD. REPLACEMENT OF THE DISK CONTAINING THE
PROGRAM OR USER MANUAL IS YOUR EXCLUSIVE REMEDY AND SOLE
MEASURE OF RECOVERABLE DAMAGES.
Disclaimer
The Package (The program and the User Manual) is licensed "as is", without
warranty of any kind, either express or implied, including but not limited to the
implied warranties of merchantability and fitness for a particular purpose, without
limitation; all warranties against infringement or the like respecting the package
are hereby disclaimed by us. We do not warrant that any functions contained in
this package will meet your requirements or that your use of the package will be
uninterrupted or error-free.
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We shall have no liability to you or any third party regarding the package, the
User Manual or otherwise in warranty, contract, tort, or otherwise. In no event will
we be liable for any direct, incidental, special, indirect, general, or consequential
damage or loss of any nature (such as damage to property, damages resulting
from delay, claims of third parties, loss of profits, or injury to person) which may
arise in connection with the use of or inability to use this package. This clause
shall survive failure of an exclusive remedy. We specifically disclaim liability for
any and all forms generated by the Package for submission to CRA or Québec's
Ministère du Revenu. It is the users' responsibility to ensure that the proper
forms are used and, with respect to the Relevé slips, that the serial numbers on
the forms are unique and within the range assigned to the user by ELM
Computer Systems, Inc.

Getting Started
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Chapter 2 - Getting Started
Installation
T4 TimeSaver may be installed on any hard disk drive accessible to your
computer. Single User and Network installations are described below. If you
used T4 TimeSaver last year, you may install the program without affecting last
year’s database, nor will reinstalling the current program affect the current year’s
database.
We strongly recommend against storing data files on floppies as data loss will
occur when the database exceeds the capacity of the floppy disk. For fastest
program response and most secure retention of data it is recommended that data
files be stored on either a local or network hard disk. Data files can also be
stored on many USB flash drives provided sufficient space is available.
To install T4 TimeSaver from the CD follow these steps:
1. Copy the original CD media and store the originals in a safe place.
2. Close all open applications, this will avoid possible conflicts with open
programs.
3. Insert the copy of the installation CD in an appropriate drive.
4. Click on the Start button in the lower left corner. Select Run from the
menu displayed. Type d:t4setup (replace “d:” with the drive letter in which
the install CD is located.) Click OK to continue.
To install T4 TimeSaver from the internet follow these steps:
1. Download the installation package from our website:
http://www.t4timesaver.ca/contents/t4_timesaver_downloads.html
2. Close all open applications, this will avoid possible conflicts with open
programs.
3. Click on the Start button in the lower left corner. Select Run from the
menu displayed. Type location\t4setup (replace “location” with the name
of the folder to which you downloaded the installation package.) Click OK
to continue.
When the setup program begins, follow the directions on your screen.
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Single User Installation:
Install and run T4 TimeSaver on a stand-alone workstation. Select Workstation
from the Select Type of Install window. This will install the program on either the
local hard drive or any network drive available to the computer, placing all
resources required by the software only on the local workstation.
Network Installation:
Install and run T4 TimeSaver on a network drive. Select Network
Administrator from the Select Type of Install window to install the program on
a network drive. Then, run T4NODE.EXE from each workstation to copy the
necessary files to run the program from the workstation.

Starting the Program
The Start menu will contain the T4 TimeSaver icon in the T4 TimeSaver program
group.

Registration
Your copy of T4 TimeSaver must be registered before all functionality of the
program is activated. Click on the Registration button on the registration screen
and enter the unique authorization number issued to you by ELM Computer
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Systems to register this copy of the program. You can then click on the Start
button on the registration screen to begin using T4 TimeSaver.
You may enter data into the T4 TimeSaver without registering the program but
you will be unable to produce a valid return until the registration number is
entered. (Many functions will also be unavailable until the software is registered.)

The opportunity to register will be available every time you start the program until
registration has been completed.
T4 TimeSaver program is copyright (c) 1987-2006 by ELM Computer Systems
Inc. Please refer to the License Agreement in Chapter 1 for full details of the
agreement between ELM Computer Systems Inc. and users of the package.

User Names and Passwords (T4 TimeSaver Plus only)
Every time T4 TimeSaver Plus is started, you will be prompted for your user
name and password. You can enter any name you wish to for a username.
There should be a unique user name assigned to each person or workstation.
The first time you enter a new user name, you must also enter a password which
will be assigned to the user name. You will be asked to confirm that this is a new
user name. This is to prevent the creation of a new user name in the case of a
typographical error. You can change the password by selecting the Change
password option from the File menu.
Each user name is associated with a corresponding user profile. The user profile
contains the user settings associated with the user name. You can create as
many user profiles as you require. The user settings can be unique for each user
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or there can be a number of identical users. A user profile is created by typing in
a unique entry when prompted for the user name.
Each user can establish their own settings by selecting User Setup Options
from the Setup menu. Preferences and default values can then be entered in
the various categories. See chapter 4 for descriptions of the various settings.
Alternatively, global settings can be established by using the User
Administration option in the Setup menu. To access this function you must
enter the user name “Admin” upon startup. With this function you can add a new
user or edit, copy or delete existing user settings.
NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLECTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY MENU.

Privacy Protection
Additionally, user names can be used to restrict access to sensitive information.
By default there is no restriction to database access, but the creator (or the
person with username “admin”) can restrict access to the database to any users
not on a user list. Select the Database Access Control from the Setup menu,
and then select Setup Database Access User List. Check the “Restrict Access
to the current database” checkbox. The database will be restricted to the creator
and the user “Admin” unless additional usernames are added to the list.

What's on the T4 TimeSaver Window?
The title bar of the main window contains the name of the program and the name
of the current database. Beneath it is the main menu. Each menu item can be
accessed by clicking its name. Under the main menu are both the current
company name and the icon toolbar. Clicking the company name will give you a
list of all the companies available in the current database and will allow you to
switch to any other company. The icons that appear in colour are available to
use.

Those that are greyed out are only available when a form is open. See the
section below on Toolbar Icons for details on the individual icons.

Use of Special Keys
The T4 TimeSaver makes use of some special keys and key combinations to
facilitate your data entry and editing.

Getting Started
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Short-cuts
Any command button that has an underlined letter can be accessed by
simultaneously pressing the [Alt] key with that underlined letter. (E.g. pressing
[Alt] + [K] would have the same affect as clicking on the OK button.)
In the same way, each menu title at the top of the window can be selected by
simultaneously pressing the [Alt] key with the underlined letter. When the menu
is open, you can select from the list of topics by simply typing the underlined
letter (without the [Alt] key).
Many of the menu items have short-cut key strokes which can be used instead of
opening up the menu and selecting the function. These are listed below:
F1 ............... Accesses on-line help
Ctrl + P ....... Opens print window (with current employee selected, where applicable)
Ctrl + A ....... Adds a slip to the current company
Ctrl + D....... Deletes the current slip from the current company data
Ctrl + S ....... Allows you to select from the list of employees for the current company
Ctrl + PgUp Moves to the first slip for the current company
PgUp .......... Moves to the previous slip for the current company
PgDn .......... Moves to the next slip for the current company, adding a new slip if current
slip is the last slip
Ctrl + PgDn Moves to the last slip for the current company
F9 ................ Switches between a T4 or T5 and its corresponding RL-1 or RL-3
Ctrl + G........ Switches between a slip and its corresponding Summary
Ctrl + J......... Adjusts the current employee’s T4 or RL-1 slip

Special Keys for Data Entry
During data entry the following keys may prove useful:
Tab or Enter Moves to the next data entry field.
Shift + Tab .. Moves to the previous data entry field.
Esc .............. Exits the current screen.
Home .......... Moves to the beginning of a data entry field.
End.............. Moves to the end of a data entry field.
Del............... Erases the character under the cursor.
Backspace .. Erases the character to the left of the cursor.
F2 ................ Opens a combo box (a box with a black top right corner, containing multiple choices).
F4 ................ Allows you to override a calculated field.
F5............... Formats the employee name as “SURNAME, First name”.
Up-Arrow..... Moves to the previous selection in a list.
Down-Arrow Moves to the next selection in a list.
PgUp ........... Moves by pages up through a list.
PgDn ........... Moves by pages down through a list.
Shift+F6 ..... Inserts the company address to an employee’s slip.
F7 ................ Copies the address and S.I.N. for the current employee to a clipboard.
Shift + F7..... Pastes the address and S.I.N. from the clipboard to the current employee.
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Toolbar Icons
The toolbar is located directly below the main menu. The icons in the toolbar
provide shortcuts for some of the common functions of the T4 TimeSaver
program.
Add a New Company. This function creates a new company within the
current database. You must enter a company name that is unique to the
database. You can have as many companies in the database as you wish.
Open a Company in the Current Database. Clicking this icon will produce
a list of the company names for all the companies in the current database.
Select the desired company by highlighting it and clicking Select.
Edit the Current Company Information. This function opens the current
company information window and allows you to edit the information for the
current company. You can change the company name, address, business
number, EI rate, or adjustment options.
Find a Company by Name. Clicking this icon opens the "Find Company"
dialog box. Type in the company name (or part of it) and select either "All
databases in directory" or "Current database only". Then click on the Find
button. T4 TimeSaver will generate a list of companies that contain the desired
name (or part of name). Select a particular company by locating and highlighting
the desired company name and clicking Select (or double-click on the correct
company name).
Print the Current Form. Clicking this icon will open the print window with
the company and employee already selected allowing you to print a single slip or
summary. Choose the type of form and the copy number that you require. You
can also adjust the margins and select printers from the same dialog box. [Ctrl] +
[P] performs the same action. See Chapter 9 - Producing Reports.
Add a Slip. This function creates an empty slip of the same type as you
are currently accessing. [Ctrl] + [A] performs the same function. Pressing [PgDn]
when you are at the final slip for the company also adds a new slip.
Delete this Slip. This deletes the current slip. [Ctrl] + [D] performs the
same function. If you delete the only slip, the slip window will be closed.
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Find a Slip. This provides you with a list of all the employees entered for
the current company. [Ctrl] + [S] performs the same function. Select the desired
employee from the list by highlighting the name and then clicking Select or
simply double-clicking on the employee name.
Go to Summary/Go to Slips. Clicking this icon toggles between the
Summary report and the slips for the type of form currently being displayed for
the current company. [Ctrl] + [G] performs the same function.
Adjust this T4 Slip. This function calculates and makes any adjustments
necessary for the current slip, based on the adjustment options entered for the
current company. [Ctrl] + [J] performs the same function. The adjusted values
will appear below the entered values.
The buttons below are only visible when an information return is being displayed.
Clicking this icon moves to the first slip for the current company. [Ctrl] +
[PgUp] performs the same function.
Clicking this icon moves to the last slip for the current company. [Ctrl] +
[PgDn] performs the same function.
Clicking this icon moves to the previous slip for the current company.
[PgUp] performs the same function.
Clicking this icon moves to the next slip for the current company. [PgDn]
performs the same function.

Input Conventions
The decimal point should be used to enter cents. Where no decimal point is
entered, the system will assume and display zero cents when the [Tab] or [Enter]
keys are pressed, or you move the cursor to another field.
New data entered in a field will overwrite previously entered data. You may edit
existing data by using the left and right cursor control keys, as well as the
[Backspace], [Delete], [Home], and [End] keys.
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Getting Help
Whenever you require help press the [F1] key to access the on-line help screens.
If context-sensitive help is available it will be displayed. Otherwise use the table
of contents to access the desired topic. Hyperlinks to related topics are provided
for your convenience.
You can also access the help files from the Help menu. The Contents option
will access the table of contents for the Help Pages. The Search for help on
option will access the help index. The Internet sites submenu lists a number of
Internet sites that may prove helpful.
During a technical support session our staff may request that you supply a copy
of your database or a record of the settings currently being used by T4
TimeSaver installation at your location.
To send ELM a copy of your current database select the Help menu, then the
Send an E-mail to Technical Support sub-menu, then the Send Current
Database sub-menu. Please be assured that we will treat any data sent to us
with the strictest of confidence and will delete all copies once your question has
been answered.
To send ELM a listing of your current program settings select the Help menu,
then the Send an E-mail to Technical Support sub-menu, then the Send Other
Email sub-menu.
Please note that client confidentiality agreements between your office and its
clients may prohibit sending client and/or corporate data to an other entity such
as ELM.

Working with Databases
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Chapter 3 - Working with Databases
Creating a Database
A T4 TimeSaver database is a collection of the data for one or more companies
in a single file on your computer. Each database can contain the data for
numerous companies and you can create as many databases as you wish. To
create a database select New database from the File menu.
First, select the folder in which you want to store the database. You can select
any local or network folder available to your computer. If a multi-user network
version of T4 TimeSaver is being used, the database should be stored on a
network drive so that it can be accessed by all users. Next, you will need to give
the database a name. Enter a valid Windows filename. If you enter the
extension, it must be ".t05". If no extension is entered the extension will default
to ".t05".

Click Save to create the database and exit the Create New Database dialog
box. The new database will be automatically opened and its name will appear in
the title bar of your T4 TimeSaver window.
If you already have a database open when you choose New database the
current database is automatically closed before the new database is created and
opened unless you cancel the procedure.
By default there is no restriction to database access, but the creator (or the
person with username “admin”) can restrict access to the database if desired.
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Select the Database Access Control from the Setup menu, and then select
Setup Database Access User List. Check the “Restrict Access to the current
database” checkbox. The database will be restricted to the creator, the user
“Admin” and any additional usernames added to the list.

Opening a Database
To work with an existing database, you must open it. Choose Open Database
from the File menu. Select the path and folder that contains the required
database. Select or type the name of the document you want to open in the File
name field. This box only lists documents with the filename extension ".t05".
If no database exists you will need to create one by selecting New database
from the File menu.
NOTE: IF YOU ARE UNABLE TO ACCESS MOST ITEMS UNDER THE
“COMPANY” MENU THE MOST LIKELY CAUSE IS THAT NO DATABASE IS
OPEN IN T4 TIMESAVER. YOU WILL ONLY BE ABLE TO CREATE
COMPANY INFORMATION IF A DATABASE IS OPEN IN THE T4 TIMESAVER.

Closing a Database
Close the current database by selecting Close database from the File menu.
The database must be closed to allow you access to the file through your
operating system in order to move or backup the file without closing T4
TimeSaver.

Deleting a Database
Ensure that the database you wish to delete is closed. Select Delete database
from the File menu. Locate and highlight the name of the database to be
deleted and then click the OK button. You will be asked to confirm the deletion.

Renaming a Database
To rename an existing database you must first close the database. Select
Rename database from the File menu. Locate and highlight the name of the
database you wish to rename and click the OK button. You will be asked to
enter the new name of the database file. Ensure that the correct filename is
entered, including the path and the “.t05" extension and again click the OK
button.
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Finding a Database
To find an existing database you can select Find database from the File menu.
You will be asked to specify a folder in which to look for database files from
either the current taxation year, the previous taxation year, or both. All subfolders of the specified folder will also be searched.
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4-1

Chapter 4 - User Setup Options
T4 TimeSaver comes with many user-definable settings to make it more flexible
and efficient. Before entering data, you may wish to configure the program to
your specific needs. If you are using the T4 TimeSaver Plus, these settings can
be different for each user.
NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLECTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY MENU.

Data Entry Tabs
Each data entry screen contains a number of boxes corresponding to the boxes
on the printed form. It may not be necessary for you to enter information into
each box as some boxes may be left blank or they may contain a default value.
Place a check mark beside the name of each box where you want the cursor to
stop and remove the check mark from beside any box where you do not require
the cursor to stop in the Data Entry tabs for each type of slips. When you are
finished, click on the OK button to save your selection.
The following is a sample of the T4 Data Entry tab:

During data entry, pressing the [Tab] key or the [Enter] key will move you from
one checked box to the next. Pressing [Shift] + [Tab] will move you back to the
previous checked box. Use the space bar to check and uncheck boxes. If, on a
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particular form, you need to edit a box that would normally be skipped, you can
use your mouse to place the cursor within the field and then type in the data.

T4 Adjustment Defaults Tab
Complete the T4 Adjustment Defaults tab. The information on this tab will be
copied to the T4 Adjustment Options tab of the Company Information window for
each new company. See further information in Chapter 7 Adjusting T4s and
Relevé 1s regarding how to set the adjustments to best suit your needs.

New Company Defaults Tab
Complete the New Company Defaults tab. This information will be
automatically entered into each new company you set up. You may override
these defaults for individual companies as you set them up.

User Setup Options
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Magnetic Media Tab
The Magnetic Media tab contains information required by the system to submit
T4, NR4, T4A, T4A-NR, T5, T1204, RL-1, RL-2, RL-3, and RL-25 returns on
diskette, CD or DVD. Enter the name and address of the company responsible
for transmitting the magnetic media data. You should also enter names and
phone numbers for accounting and technical contacts. If CRA has assigned a
transmitter number for federal forms, it should be entered. If you will be filing
RL-1 and/or RL-3 returns you must contact the Ministère du Revenu to receive a
transmitter number and a set of serial numbers. See Chapter 10 – Filing by
Magnetic Media for further information regarding magnetic filing.
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You do not have to submit a test diskette to either the CRA or the Quebec
government before filing your returns on diskette. We have already received
approval for the magnetic media format on your behalf.
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Chapter 5 - Company Information
Creating a Company
You can enter as many companies as you would like into each database, as long
as each company has a unique name. To create a new company in the current
database, select New Company from the Company menu. Company
information is entered on the Identification tab and the T4 Adjustment Options
tab.
Identification
You must enter a company name which is unique to the current database. (It is
possible to have the same company name in different databases.) You should
also enter as much of the requested company information as possible when you
add a new company.

You must enter a valid business number if you wish to file slips and summaries
for this company using magnetic media processing. T4 TimeSaver will
automatically use the default values for the Tax Centre, the Taxation Services
Office Code, and the Default Province of Employment that you entered on the
New Company Defaults tab in the Setup menu. You may make any changes
required for this particular company by simply typing in the correct information.
The company category field is a self defined field that allows you to group the
companies into categories. Enter a different company category name for each
group of companies you require. This will allow you to print reports that include
only the companies in the specified category. See Using Filters in Chapter 9.
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T4 Adjustment Options.
With the T4 TimeSaver you have the flexibility of customizing your method of
adjusting CPP/QPP and EI discrepancies for individual companies. When you
add a new company, T4 TimeSaver will automatically insert the default values
that you entered on the T4 Adjustment Defaults tab in the Setup menu.

You may make any changes required for this particular company by simply typing
in the correct information. For further information see Chapter 7 Adjusting T4s
and Relevé 1s.
If, for a specific company, you have changed the values for the Tax Centre, the
Taxation Services Office code, or the Default Province of Employment, on the
Identification tab (or any of the options on the T4 Adjustment Options tab)
pressing the User Defaults button will restore the default values that are stored
in the User Setup Options. You will be asked to confirm your choice.

Selecting a Company
To switch to another company, choose Selecting a Company from the
Company menu. A list of all the companies stored in the current database will
appear. Highlight the desired company and press [Enter] or click on the company
name. You can perform the same function by simply clicking on the current
company name visible at the top of the form.

Company Information
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Editing Company Information
You can edit the company information by selecting Edit Company Information
from the Company menu.

Replicate Company Address
This button will copy the information in the current company address and care-of
lines to all companies in the current database.
Replicate Employee Address
This button will copy the information in the Default Employee Address section of
the data entry screen to all employees of the current employer (or all slips for the
current company).
User Defaults
If you have changed any of the adjustment options, pressing the User Default
button will restore the default values that were recorded during setup. You will be
asked to confirm the copying of this information.
Sometimes it may be necessary to make changes to the T4 Adjustment options
for a number of companies. Instead of making the changes on each company's
T4 Adjustment Options tab you can make the changes on the T4 Adjustment
Defaults tab in the Setup menu. Then simply press this User Defaults button on
the T4 Adjustment Options tab for each individual company.

Finding a Company
To locate a company, select Find Company from the Company menu. The Find
Company dialog box will open.
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Type in a full or partial company name and select the scope of the search by
clicking on either "All databases in directory" or "Current database only". Then,
click on the Find button.

Once all the matching company names have been listed, double click on the
required company name or highlight it and press Select. The selected company
and its database will become the current company and database.

Deleting a Company
Delete the current company, and all slips and summary forms associated with the
company, by selecting Delete Company from the Company menu. You will be
given a warning and asked to confirm the deletion of the company by typing the
word "DELETE".

Remove all Slips
This function will remove all slips of any type from the current company. This is
useful if you wish to initialize the employee data for a given company. Enter the
type of slips you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4", “T4PS”,
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“T4AP”, “T4ARCA”, “T5013”, “T5018”, “R2”, “R15”, “R17”, “R25”or “T1204”), or
“ALL” if you wish to remove all slips of every type for this company..

Remove Inactive Slips
This function will remove slips that have all dollar values set to zero. This is
useful for eliminating slips for employees that are no longer with the company,
but for whom there is still a name and address in the database. Enter the type of
slips you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4", “T4PS”, “T4AP”,
“T4ARCA”, “T5013”, “T5018”, “R2”, “R15”, “R17”, “R25” or “T1204”), or “ALL” if
you wish to remove inactive slips of every type for this company.

Adjust/Unadjust Company’s T4s/RL-1s
This function allows you to adjust the CPP/QPP and/or EI for all of the employees
in a given company at one time. The adjustments will be made according to the
adjustment options you have entered for the company. See Chapter 7 –
Adjusting T4s and Relevé 1s for further information about the adjustment options.
You may also remove the adjusted values and return to the entered values by
selecting the Undo Adjustment button from this window.
The Adjustment Options button opens the adjustment options data entry
screen for the current company. You can verify or edit the adjustment options for
the company before calculating the adjustments.
Check the Print adjustment report box if you desire such a report for your
records. You can all print this report by selecting T4 then Adjustments from the
Reports menu.

Unlock all companies in database
From time to time you may receive a message stating that a certain record has
been locked by another user. If, in fact, no other user is accessing the database
this message indicates that a record has been left locked in error. Selecting this
function from the Company menu will unlock all of the locked records and allow
you access once again. Be careful to ensure that all other users are at the main
menu without any form or company records open when this function is utilized.

Refresh from Database
In situations where more than one person is entering data for the same company
data entered by one individual may not always be visible to an other. Selecting
this option from the Company menu will cause T4 TimeSaver to reload the data
for this company and enable it to display data entered by other users.

Entering Slips
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Chapter 6 - Entering Slips
Choose the type of slip you wish to enter by selecting it from the Forms menu.
The following are some of the functions you can use:

Adding Slips
This function is used to add a new slip, of the same type as you are currently
entering, to the active company. Access this function by selecting Add Slip from
the Edit menu, clicking on the Add Slip icon in the icon toolbar, or by pressing
[Ctrl] + [A]. A blank slip will appear in which you may enter the information for an
individual slip.
After entering data in a box you may press either the Enter or Tab key and the
cursor will move to the next box. The cursor only stops at the boxes that have
been checked off on the corresponding Data Entry tab of the Setup menu.
(Note: there are Data Entry tabs for the most commonly used form types – T4,
T4A, T5, RL-1, and RL-3.)
You will be warned if the data you have entered is invalid.

Deleting Slips
Select Delete Slip from the Edit menu, or click on the Delete Slip icon in the
icon toolbar, or press [Ctrl] + [D]. This function will delete the slip currently
displayed on the screen. You will be asked to confirm the deletion.
If you delete the only slip, the slip window will be closed.

Remove all Slips
This function will remove all slips of any type from the current company. This is
useful if you wish to initialize the employee data for a given company. Enter the
type of slips you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4", “T4PS”,
“T4AP”, “T4ARCA”,“T5013”, “T5018”, “R2”, “R15”, “R17”, “R25” or “T1204”), or
“ALL” if you wish to remove all slips of every type for this company..
Note: RL-1 slips will be removed with the corresponding T4 slips and RL-3 slips
will be removed with the corresponding T5 slips.

Removing Inactive Slips
Select Remove Inactive Slips from the Company menu to delete only those
slips that have all dollar values equal to zero. These would be employees that
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were imported or converted from a previous year, but were not employed in the
current year.
Enter the type of slip you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4",
“T4PS”, “T4AP”, “T4ARCA”, “T5013”, “T5018”, “R2”, “R15”, “R17”, “R25” or
“T1204”), or type “ALL” to remove all inactive slips of any type for this company.
Note: You can determine whether inactive slips exist by creating a Company
Summary Report. The report will list the number of active and inactive slips of
each type for the company.
Note: Inactive RL-1 slips will be removed with the corresponding inactive T4
slips and inactive RL-3 slips will be removed with the corresponding inactive T5
slips.

Finding Slips
Choose Select slip from list from the Edit menu to display a list of all the
employees for the current company. Clicking on the Find Slip icon in the icon
toolbar or pressing [Ctrl] + [S] performs the same function. Select from the list by
either double clicking on the desired employee or by highlighting the name and
then clicking on Select or pressing the enter key. The slip for the employee
selected will appear on the screen.

Sorting Slips
When displaying various slips you can modify their sort order by selecting the
desired field from the Select Order of slips field in the icon toolbar (located to
the left of the slip number field). This function will change the order of the slips
from the current sort order to the order designated by the field displayed in the
Select order of slips field (the fields available for sorting will vary by the type of
slip being edited. The slip currently being displayed will remain on the screen.

Entering Data
The data entry screen for each type of slip contains input fields that correspond
to the boxes on the printed forms. Descriptions of some of these boxes are listed
below under the appropriate type of slip. For the other boxes see the Employers'
Guides provided by CRA for information about the regulations concerning the
contents of any of the particular boxes.

Overriding Calculated Fields
Some fields on the slips and summaries contain calculated values. These values
will appear in blue type. If it becomes necessary to edit a calculated field you
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may do so by pressing the F4 key. The background colour of the field will
change to indicate the value is no longer the calculated value and you will be able
to enter the desired value. To return to the calculated value, click the
Recalculate button.
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T4 Input Window

Note: The Provincial Parental Insurance Program (PPIP) is not to be used on tax
returns for 2005. PPIP comes into effect for 2006 returns.
Employee Name
The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered.
Province Code
T4 TimeSaver will automatically insert into Box 10 the code for the province of
employment entered on the Identification tab of the Company Information.
You may, of course, override it for a specific employee. If the province code is
set to "QC", the Employee's QPP contribution box is included in the data entry
fields and you will be unable to access the CPP box. If any other province code
is entered, the Employee's CPP contribution box will be accessible but not the
QPP box. Also, if the province code is QC, a Relevé 1 slip can be accessed by
pressing F9 or clicking the Go to RL-1 button.
S.I.N. Validation
T4 TimeSaver will check the validity of the S.I.N. entered and will change the
background colour of the S.I.N. field to red if the S.I.N. is invalid. You can,
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however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. is found in the CRA Publication:
Formulae for Federal and Provincial Deductions for Computer Users.
When the edit list or detailed adjustment report is printed or displayed, there will
be an asterisk beside any invalid S.I.N. values.
CPP Pensionable Weeks
If you have selected "Adjust based on number of pensionable weeks" for the
CPP/QPP Adjustment Option on the T4 Adjustment Options tab of the
Company Information, a value must be entered into the input field "CPP
Pensionable Weeks". This field will default to 52 or 53 depending on the value
entered under Maximum Number of Pensionable Weeks, but you may override
this value for specific employees.
EI Insurable Earnings
A value should only be entered in the EI Insurable earnings box when it is not
equal to the gross pay amount (Box 14) or zero. If no amount in entered, Box 24
will be left blank on the printed slip as required by CRA.
CPP/QPP and EI Exempt Boxes
You may check one, both, or neither of the CPP/QPP and EI Exempt boxes as
appropriate for the current employee.
Do not check the CPP/QPP exempt box if you entered an amount in Box 16 or
Box 26. Check CPP/QPP exempt only if the earnings were exempt for the entire
period of employment.
Do not check the EI Exempt box if you entered an amount in Box 18 or Box 24.
Check EI exempt only if the earnings were exempt, or if they were not eligible for
the entire reporting period of employment.
Do Not Adjust CPP/QPP and EI Boxes
Check one or both of these boxes to indicate that this particular slip should not be
adjusted when the slips for this company are adjusted. This allows you to adjust
some slips while leaving others as entered.
Other Income
Record other income in the boxes provided at the bottom of the window. The
type code of the income should be indicated in the Boxes with the corresponding
Amounts directly beneath. Press F2 or double click the box field to display a list
of available codes. See your Tax Guide for a list and description of appropriate
type codes.
Amended T4s
Click on the check box labeled “Amended” to indicate that the T4 is an amended
one. This will cause the word "AMENDED" to be printed across the top of the slip
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as required by CRA. It will also cause the slip to be included whenever the
“Amended only” option is chosen during printing of the T4 slips or the T4
Summary, and excluded when “Originals only” is chosen.
Net Pay Calculation
The employee's net pay is calculated and displayed on the screen as you enter
data into each box of the T4 and may prove useful as an audit check. It will be
calculated in one of the two following ways:
Gross Pay - Standard Deductions - Other Deductions; or
Gross Pay - Standard Deductions - Taxable Benefits - Other Deductions.
The Gross Pay is the amount entered in Box 14. The Standard Deductions
include the values entered in Boxes 16, 17, 18, 20, 22, 44 and 46. Note that the
Standard Deduction includes both provincial (Québec) and federal taxes.
Taxable Benefits is the sum of the “Amounts” boxes which represent taxable
benefits. Other deductions (if there are any) must be entered manually to arrive
at the appropriate figure for Net Pay.

You can switch between these two methods of calculating the Net Pay by clicking
on the Net Pay button and then selecting the appropriate option. You can also
check the "Don't display net pay" to remove this information from the display.
Go to RL-1
Use this button to create and/or access the corresponding RL-1 for this
employee.
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NR4 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
Recipient Type Code
Enter one of the following valid codes to identify the types of recipient:
1, if the income was earned by an individual
2, if the income was earned by a joint account (two individuals).
3, if the income was earned by a corporation.
4, if the income was earned by an association, a trust (fiduciary-trustee, nominee,
or estate), a club, a partnership, or other.
5, if the income was earned by a government, government enterprise, or
international organization.
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Income Code
Enter the appropriate numeric income code, or select one from the drop down
list, to indicate the source of the income being reported.
Currency Code
Gross income and non-resident tax withheld should be reported in Canadian
funds. However, CRA will convert both these values to Canadian currency based
on the currency code entered here and the average annual rate. Ensure that
both the gross income and the non-resident tax withheld are in the same
currency and that the appropriate three letter code is selected.
Exemption Code
Enter the applicable exemption code, or select it from the drop down list. See
Appendix C in the CRA Publication T4061Non Resident Withholding Tax Guide
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T4PS Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Automatic Calculations
The Taxable Amount of Dividends and the Federal Dividend Tax Credit are
calculated and displayed automatically by the system as follows:
Taxable Amount of Dividends = (Actual Dividends) * 1.25
Federal Dividend Tax Credit = (Actual Dividends) * 1/6
This calculation does not apply for any corporate recipients or any recipient that
is a charitable organization.
Recipient ID Number Validation
If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,
however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. or business number is found in the
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CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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T4A Input Window

Employee Name
The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered.
S.I.N. Validation
The T4 TimeSaver will check the validity of the S.I.N. entered and display a
warning if it is invalid. You can, however, ignore the warning and continue to
enter other information. The formula used to test the value of the S.I.N. is found
in the CRA Publication: Formulae for Federal and Provincial Deductions for
Computer Users.
Footnotes
Text footnotes may be entered in the fields provided. These will be printed on
paper copies of the T4A. (Footnotes for use with Magnetic Media submissions
may be accessed by clicking on the Mag. Media command button in the top right
corner of the screen.) Type the word "amended" (in upper, lower, or mixed case)
in the footnote section to indicate that the T4A is an amended T4A. This will
cause the word "AMENDED" to be printed across the top of the slip as required
by CRA. It will also cause the slip to be included if you choose “Amended only”
when printing T4A slips or the T4A Summary.
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Go to RL-1
Use this button to create and/or access the corresponding RL-1 for this
employee. There must also be a corresponding T4 for the same employee with
the province of employment set to “QC”.
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T4A-NR Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Country of Residence
Enter the appropriate three character country code, or select it from the drop
down list, to indicate the country of residence of the recipient. See Appendix E
for a full list of the standard three character country codes.
Non-Resident’s Service Industry
Enter the four digit numeric code, or select it from the drop down list, indicating
the type of service industry.
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
City/Province where services rendered
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Enter the city name, leave a space and then type the two character province
code for the province in which the services were rendered.
Days in Canada
Enter the total number of days the non-resident was in Canada during this
calendar year while under contract with the payer. Include weekends and
holidays.
Professional Name
Use this box if the professional or operating name is different from the real or
legal name of the non-resident. For example, this box may be used when
payments are made to non-residents in the entertainment and athletic
professions.
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T4A(P) Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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T4A(RCA) Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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T5 Input Window

Recipient Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered.
Recipient ID Number Validation
If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,
however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. or business number is found in the
CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.
Report Code
This code helps CRA determine if this is the original T5 slip issued to the
recipient, or if it amends the original.
Enter 0, if this is the original slip.

6-18

T4 TimeSaver User Manual

Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).
Recipient Type
Enter one of the following valid codes to identify the type of recipient:
1, if the investment income was earned by an individual
2, if the investment income was earned by a joint account (two individuals).
3, if the investment income was earned by a corporation.
4, if the investment income was earned by an association, a trust (fiduciarytrustee, nominee, or estate), a club, a partnership, or other.
5, if the investment income was earned by a government, government enterprise,
or international organization.
Currency Code
If you cannot report amounts in Canadian dollars, identify the foreign currency
according to the ISO (International Organization for Standardization) 4217 Codes
for the Representation of Currencies and Funds. Enter the appropriate threeletter alphabetical or three-digit numeric codes. If possible, use the alphabetical
codes. For example:
USD - United States, dollar
JPY - Japan, yen
SVC - El Salvador, colon
FRF - France, franc
HKD - Hong Kong, dollar
ITL - Italy, lire
DEM - Germany, mark
DKK - Denmark, kröne
GBP - United Kingdom, pound
ESP - Spain, peseta
Leave this area blank if you are reporting the amount in Canadian dollars. If you
must report amounts in different currencies in respect of the same recipient, use
a separate T5 slip for each currency.
Automatic Calculations
The Taxable Amount of Dividends and the Federal Dividend Tax Credit are
calculated and displayed automatically by the system as follows:
Taxable Amount of Dividends = (Actual Dividends) * 1.25
Federal Dividend Tax Credit = (Actual Dividends) * 1/6
This calculation does not apply for any corporate recipients (recipient type 3) or
any recipient that is a charitable organization.
Relevé 3 Required
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If a Relevé 3 will be printed for the current recipient, check the Relevé 3
Required box. You can then use the Go to RL-3 button in the top right corner of
the form to view and edit the Relevé 3 slip.
Note that Revenu du Québec has specified that where the recipient is a
corporation (i.e. the recipient type code is 3), the dividend income should be
entered on the RL-3 as Other income from Canadian sources (box E) and not as
Actual amount of dividend (box A). This will prevent the calculation of the
Federal Dividend Tax Credit for corporations. When adding a new T5 slip with
recipient type code of 3, any amount entered in box 10 will be added to income
entered in box 14 and will be carried over to box E of the corresponding RL-3
slip.
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T5013 Input Window (Plus version only)

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
Units or interest owned
Enter the number of partnership units, complete to all decimal places, held by the
partner.
Partner’s share (%) of income (loss)
This value will be calculated based on the Units or Interest Owned of all the
partners in the partnership.
Recipient Type Code
Enter one of the following valid codes to identify the types of recipient:
1, for an individual, other than a trust;
3, for a corporation; or
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4, for a trust or a partnership.
Country Code
Enter the appropriate three character country code, or select it from the drop
down list, to indicate the country of residence of the recipient. See Appendix E
for a full list of the standard three character country codes.
Member Code
Enter the Member code used to identify the partner’s membership status within
the partnership for income tax purposes. Use:
0, for a limited partner, at any time during the fiscal period;
1, for a specified member who is not a limited partner;
2, for a general partner; and
3, for a limited partner’s exempt interest as defined in subsection 96(2.5).
Boxes 18-45
These fields will be automatically filled based on the partner’s share of the net
income or loss and the amounts given on the T5013 summary. To override a
calculated value, press the F4 key and then type in the desired value.
Recalculate
Click on this button to redistribute the amounts given on the summary, according
to each partner’s share. You have the option of recalculating all fields, or only
those fields that have not been overridden.
Go To
Use these buttons to switch between pages of input fields.
Boxes 18-32:
Displays boxes 18-32
Boxes 33-45:
Displays boxes 33-45
Section 2:
Displays section 2, boxes 53-58
Section 3:
Displays section 3, boxes 130-140
Details:
Displays details field for text
T5015:
Displays the T5015 data fields
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T5014 Input Window

Class Number
Enter up to 15 different class numbers (1-5 on page 1, 6-10 on page 2, and 1115 on page 3). Class numbers range from 1 to 47. For a complete listing of valid
class numbers press the F2 key. The applicable rate will automatically be
entered into column 9 and be used in the capital cost allowance calculation.
Adjustments
Enter the corresponding adjustments. Increases to capital costs should be
entered as positive values, decreases as negative values.
Undepreciated capital cost
This value will be automatically calculated using the values entered in columns 2
through 5.
Total CCA
This box will contain the value of the sums of all the amounts listed in column 10.
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T5015 Input Window

This will take you directly to the T5015 page, which is located on the T5015
section of the T5013 Input Window. The top half of the form will already be
completed if you have entered the T5013 information. Enter values for the
Capital account start of period, Capital contributed during period, Income
allocated during period, and Drawings. The Capital account end of period will be
automatically calculated.
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T5018 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Construction subcontractor payments
Enter the total payment received by the subcontractor during the period specified
on the T5018 Summary.
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
Recipient ID Number Validation
If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,
however, ignore the warning and continue to enter other information. The
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formula used to test the value of the S.I.N. or business number is found in the
CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.
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T1204 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
Recipient Type Code
Enter one of the following valid codes to identify the types of recipient:
1, for an individual, other than a trust;
3, for a corporation; or
4, for a trust or a partnership.
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Relevé 1 Input Window

A Relevé 1 will always be added when a T4 is created that has "QC" entered as
the Province of Employment. Conversely, a T4 will also be added automatically
for each Relevé 1 entered. Note that the Province of Employment is always "QC"
for any RL-1 created.
When you are adding a Relevé 1 or a T4, all the relevant values (dollar amounts,
name and address, etc.) are carried over to the corresponding form. Footnotes
and boxes that are specific only to the Relevé 1 or the T4 will not be carried over.
See Appendix F - Equivalent fields on T4 and Relevé 1 Slips for further details.
Employee Name
The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters
and ensure that the first letter of the first name is capitalized (e.g. SMITH, John).
S.I.N. Validation
T4 TimeSaver will check the validity of the S.I.N. entered and display a warning if
it is invalid. You can, however, ignore the warning and continue to enter other
information. The formula used to test the value of the S.I.N. is found in the CRA
Publication: Formulae for Federal and Provincial Deductions for Computer Users.
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QPP Pensionable Weeks
If you have selected "Adjust based on number of pensionable weeks" for the
CPP/QPP Adjustment Option on the T4 Adjustment Options tab of the
Company Information, a value must be entered into the input field "QPP
Pensionable Weeks". This field will default to 52 or 53 depending on the value
entered under Maximum Number of Pensionable Weeks, but you may override
this value for specific employees.
Footnotes
Text footnotes may be entered in the fields provided.
Net Pay Calculation
The employee's net pay is calculated and displayed on the screen as you enter
data into each box of the RL-1 and may prove useful as an audit check. It will be
calculated in one of the two following ways:
Gross Pay - Standard Deductions - Other Deductions; or
Gross Pay - Standard Deductions - Taxable Benefits - Other Deductions.
The Standard Deductions include the values entered in Boxes B, C, D, E, F, and
N, plus Box 22 (Income tax deducted) of the corresponding T4. Taxable Benefits
is the sum of Boxes H through L and P. Other deductions (if there are any) must
be entered manually to arrive at the appropriate figure for Net Pay.

You can switch between these two methods of calculating the Net Pay by clicking
on the Net Pay button and then selecting the appropriate option. You can also
check the "Don't display net pay" to remove this information from the display.
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Relevé 2 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Cancelled
Check this field if the slip has been cancelled
Reléve Code
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
Enter 0, if this is the original slip.
Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).
Source of Income
Double clicking on the field or hitting the F2 key to view the complete list of
options.
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Relevé 3 Input Window

Recipient Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered
Recipient ID Number Validation
If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,
however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. or business number is found in the
CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.
Cancelled
Check this field if the slip has been cancelled.

Entering Slips

6-31

Relevé Code
This code determines if this is the original RL-3 slip issued to the recipient, or if it
amends the original.
Enter 0, if this is the original slip.
Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).
Recipient Type Code
Enter one of the following valid codes to identify the types of recipient:
1, if the investment income was earned by an individual
2, if the investment income was earned by a joint account (two individuals).
3, if the investment income was earned by a corporation.
4, if the investment income was earned by an association, a trust (fiduciarytrustee, nominee, or estate), a club, a partnership, or other.
5, if the investment income was earned by a government, government enterprise,
or international organization.
Automatic Calculations
The Taxable Amount of Dividends and the Federal Dividend Tax Credit are
calculated and displayed automatically by the system as follows:
Taxable Amount of Dividends = (Actual Dividends) * 1.25
Federal Dividend Tax Credit = (Taxable Amount of Dividends) * 0.1083
This calculation does not apply for any corporate recipients or any recipient that
is a charitable organization.
Note that Ministère du Revenu has specified that where the recipient is a
corporation (i.e. the recipient type code is 3), the dividend income should be
entered as Other income from Canadian sources (box E) and not as Actual
amount of dividend (box A). This will prevent the calculation of the Federal
Dividend Tax Credit for corporations. When adding a new RL-3 slip with recipient
type code of 3, any amount entered in box E will be assumed to be dividend
income and will be carried over to box 10 of the corresponding T5 slip. If the
income is not dividend income, you can edit the T5 appropriately.
Currency Code
All amounts entered on a RL-3 slip should be in Canadian dollars. If this is not
possible, enter the corresponding currency code according to international
standard 4217 of the International Organization for Standardization (ISO). Enter
the appropriate three-letter alphabetical or three-digit numeric codes. If possible,
use the alphabetical codes. For example:
USD - United States, dollar
JPY - Japan, yen
SVC - El Salvador, colon

6-32

T4 TimeSaver User Manual

FRF - France, franc
HKD - Hong Kong, dollar
ITL - Italy, lire
DEM - Germany, mark
DKK - Denmark, kröne
GBP - United Kingdom, pound
ESP - Spain, peseta
If you must report amounts in different currencies in respect of the same
recipient, use a separate RL-3 slip for each currency.
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Relevé 17 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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Relevé 25 Input Window

Name
The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John).
Beneficiary Type
Enter one of the following valid codes to identify the type of recipient:
1, if the beneficiary was an individual
2, if the beneficiary was a joint account (two individuals).
3, if the beneficiary was a corporation.
4, if the beneficiary was an association, a trust (fiduciary-trustee, nominee, or
estate), a club, a partnership, or other.
5, if the beneficiary was a public body, municipality, or government agency.
6, if the beneficiary was the spouse of the settler or of the deceased.
Reléve Code
Indicate whether the current slip is an amended or amended slip. Otherwise, this
field can be left blank.
Enter 0, if this is the original slip.
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Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).
Cancelled
Check this field if the slip has been cancelled
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Chapter 7 - Adjusting T4s and Relevé 1s
Making adjustments to T4s and RL-1s
There are two methods of adjusting the T4s and RL-1s. The first method is to
use the Adjust this T4/R1 icon (or select Adjust/unadjust this T4/R1 from the
Edit menu) to adjust only the current employee. The adjustments will be made
based on the adjustment options selected for the current company. These
adjustments will not be reflected in the corresponding T4 summary, unless all of
the slips are adjusted.
The second method is to adjust all of the employees for the company at once.
To do this, select Adjust/unadjust company’s T4s/R1s from the Company
menu. You can skip any individual slips that you may not want to adjust by
checking the Do not adjust CPP/QPP and/or EI box(es). The adjustments will
be made based on the same adjustment options selected for the current
company. In this case the adjustments are reflected in the corresponding T4
Summary.
An adjustment report can be produced by checking the Print adjustment report
option on the Adjust all T4s/R1s window before clicking the Do adjustments
button. Or you can select the Adjustment report from the T4 or RL-1 submenus
of the Reports menu. In either case an Adjustment Report window will open.
See Printing Adjustment Reports in chapter 9 for further details.

Reversing Adjustments
Reverse the adjustment on an individual T4 or RL-1 by clicking on the Adjust
this T4/R1 icon (or select Adjust/unadjust this T4/R1 from the Edit menu)
again. The CPP, QPP, EI and tax will return to the originally entered values.
The adjustments on all of the slips for the company can be reversed by clicking
the Undo Adjustments button on the Adjust all T4s/R1s window.

Setting Adjustment Options
The adjustment options for each company are stored with the company profile.
Select Edit company information from the Company menu and then click the
T4 Adjustment Options tab. You can make any changes necessary for
individual companies, and also enter the S.I.N. number of the employee to
receive the transfer of over remittance of CPP/EI, if you choose.
If you are entering data for more than one company, you may want to select the
appropriate options on the T4 Adjustment Defaults tab in the Setup menu.
These global default options will then be used for each new company you setup.
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NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLECTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY MENU.

CPP/QPP Adjustment Options
A - Adjust CPP/QPP if over maximum/under minimum
If this option is selected, CPP/QPP will be adjusted to fall within the range:
Upper Limit: the lesser of:
· the CPP/QPP pensionable earnings x 4.95%;
· and $1,831.50
Lower Limit: the lesser of:
· (the CPP/QPP pensionable earnings - $3500) x 4.95%;
· and $1,831.50
If the CPP/QPP deducted is greater than the Upper Limit, it will be adjusted down
to the Upper Limit. If the CPP/QPP deducted is less than the Lower Limit, it will
be adjusted up to the Lower Limit. If the CPP/QPP deducted falls within the
range of the Upper and Lower Limits, no adjustments will be made to CPP/QPP.
This option ignores any potential reduction resulting from the annual CPP/QPP
basic exemption which must be prorated based on pensionable weeks as
outlined below. This option was implemented for situations where it is not
desirable to enter the number of pensionable weeks on each T4 slip.
B - Adjust CPP/QPP based on number of pensionable weeks
If this option is selected, CPP/QPP will be calculated as:
(CPP/QPP pensionable earnings - prorated deduction) x 4.95%

Adjusting T4s and Relevé 1s

7-3

Where the prorated deduction is calculated as:
(number of pensionable weeks / maximum number of pensionable weeks) x $3500

NOTE THAT ONLY ONE OF A OR B MAY BE SELECTED.
C - Maximum number of pensionable weeks
This number is the number of weeks in the employer's fiscal year and is used in
the above calculation to prorate the CPP/QPP basic exemption. The default
value is 52 weeks but can be changed to 53 weeks if required.

EI Adjustment Options
D - Adjust EI if over annual maximum
If this option is selected, the EI will only be adjusted if it is greater than:
· standard annual maximum of $39,000 x 1.98% or $ 819.00
NOTE THAT THIS OPTION CAN BE SELECTED ALONE OR WITH E OR F
E - Adjust EI based on Insurable Earnings
If this option is selected, the EI will be calculated as:
· EI insurable earnings x 1.98%
(If E.I. insurable earnings are not entered, gross pay will be used.)
F - Adjust EI insurable earnings based on EI deducted
This option assumes the entered amount for EI deducted is correct. When this
option is selected, EI insurable earnings will be calculated as the minimum of:
· EI deducted (box 18) / 1.98%;
· $39,000; and
· Employment income (box 14).
NOTE THAT ONLY ONE OF E OR F MAY BE SELECTED

Transfer Over Remittance
G - Transfer employer’s over remittance of CPP/QPP or EI to the following
employee
When adjustments reduce total deductions for the company, the employer’s
portion of the over-remittance may be transferred to the tax of an owner or
shareholder.
If a S.I.N. is entered here, then any net overpayment of CPP/QPP and EI
resulting from adjustments calculated by the program will be credited to the tax
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deducted for the T4/RL-1 of this employee. This adjustment will be reflected in
the adjusted tax on the Adjustment reports for the particular employee.
H - Increase the gross pay with over remittance
If an over remittance is created by the adjustments and you indicate that you
want the over remittance to be transferred to one employee (i.e. an owner or
shareholder), you may also increase the gross pay of that employee in order to
keep the net pay at the same level. If this option is chosen and the transferee’s
CPP/QPP is under the maximum deduction for the year, the CPP/QPP will NOT
be adjusted again for this underpayment.

Other Options
I - Adjust CPP/EI differences greater than
.
If an amount is entered in this box, an adjustment to CPP/QPP or EI must be
greater than this threshold in order for the adjustment to be made. If the
difference between the calculated amount and the entered amount for CPP/QPP
and EI is less than or equal to the threshold, no adjustments will be made and
the entered amounts for CPP/QPP, EI and tax will appear on the T4 slips.
J - Do you want CPP & EI to be adjusted to their calculated amounts even if
there is insufficient tax to cover the difference?
If this option is selected, it will adjust CPP/QPP and EI to their calculated
amounts although there may not be sufficient tax to make up the difference.
Where there is insufficient tax to cover the net adjustment to CPP/QPP and EI,
this difference will be posted to the T4 Summary. The shortfall is comprised of
the increase in the employer’s portion of CPP/QPP/EI and the increase in the
employee’s contribution which was not offset by tax. The employer will have to
make up the difference when filing the Summary. It would then be up to the
employer to collect the under-contributed employee’s portion from the employee.
K - Enter the maximum amount by which tax may be reduced
If item J was selected, you may enter the maximum amount by which tax may be
reduced. This option prevents the tax from being decreased to zero. For
example, if you only wanted tax to be decreased by a maximum of $100, enter
$100 in this field.
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Chapter 8 - Entering Summary Form Information
From the main menu select Forms and then select the type of Summary you
wish to view (or click on the Go to summary icon from the toolbar while editing a
slip).
All values that can be calculated from the information entered onto the slips will
appear on the summary form in blue. The remaining values will need to be
entered manually. These will generally appear as white boxes and the cursor will
move from one to the next, skipping the calculated values. See the specific form
and field below for more information.
Overriding Calculated Values
If it becomes necessary to edit a calculated field you may do so by pressing the
F4 key. The background colour of the field will change to indicate the value is no
longer the calculated value and you will be able to enter the desired value. To
return to the calculated value, click the Recalculate button.
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T4 Summary

Remittances
Enter the amount of money already remitted to CRA.
Amount Enclosed
Enter the amount to be enclosed with the T4 Summary form.
Adjustment Status
The T4 Summary will reflect the adjusted values as long as all of the employees
for the company have been adjusted. If, however, only some of the slips have
been adjusted using the Adjust this T4/R1 icon, the summary will reflect the
unadjusted values for all of the employees.
Data entry complete
Once all of the data has been input for a given company, check the data entry
complete box. This will allow you to print reports that will include only the
companies that are completed, or conversely, only the companies that are not
completed. See Using Filters in Chapter 9.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
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Page 2
Contains the rest of the information required for the T4 Summary.

Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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NR4 Summary

Non-resident Account Number
Enter the account number under which non-resident tax deductions are remitted.
This number has to match the account number shown on the remittance part of
Form NR76, Non-Resident Tax - Statement of Account.
Unreported Gross Income
Add the gross income reported on Forms NR601 and NR602.
Unreported Tax Withheld
Add the non-resident tax amounts reported on Form NR601.
Remittances
Enter the amount of money already remitted to CRA.
Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
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Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A Summary

Remittances
Enter the amount of money already remitted to CRA.
Amount Enclosed
Enter the amount to be enclosed with the T4A Summary form.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
Page 2
Contains additional information required for the T4A Summary.
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Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.

8-8

T4 TimeSaver User Manual

T4A-NR Summary

Remittances
Enter the amount of money already remitted to CRA.

Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4PS Summary

Year ending
Enter the year being reported
T4PS segment forms
If you have created segment forms, enter the number here. Segment forms are
not required if you are filing magnetically.
Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A(P) Summary

Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A(RCA) Summary

Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T5 Summary

T5 Summary Information
Fill in the year, filer ID number, language choice, and indicate whether it is an
amended or additional Summary. Also indicate if you have filed a T5 Summary
before.
T5 Slip Totals
You must enter the unclaimed dividends and interest, and the tax on this
unclaimed amount.
Person to contact about this return
T4 TimeSaver will automatically use the data entered in New Company Defaults
in the Setup menu when the company was first created. You can, however,
change the information if required.
Certification
T4 TimeSaver will automatically use the data entered in New Company Defaults
in the Setup menu when the company was first created. You can, however,
change the information if required.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
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More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.

8-14

T4 TimeSaver User Manual

T5013 Summary
The T5013 Summary has multiple pages. Across the top of the screen there are
seven tabs: one for each of the five “Areas” on the T5013 summary, one for
“Additional Amounts for Allocation” and one for “Partners”. Each tab has up to
three pages of data entry screens. Most of the data entry fields appear exactly
as they appear on the T5013 Summary. See the 2005 Guide for the Partnership
Information Return for full details on the completion of the T5013 summary.
Listed below are some of the fields that may require some additional explanation.

Area A: Identification, Page 1

Status
Leave blank if this is an original form. Otherwise, enter one of “Amended”,
“Duplicate”, or “Additional” to describe the status of the summary.
Business Code
Enter the four digit Business code from the T5013 slip box 05.
Tax Shelter’s principal business activity and code
Enter the two digit code and matching description from box 06 of the T5013 slip.

Entering Summary Information
Area A: Identification, Page 2

Area A: Identification, Page 3
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Area B: Certification

Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.
Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

Entering Summary Information
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Area C: Income/Loss

The amounts shown in Area C, lines 181 to 291, are the total of the amounts
allocated to the partners in boxes 18 to 29 on the T5013 slips. The sources of
income and losses are broken down into various categories that may be subject
to different income tax rules. Include income from both Canadian and foreign
sources in Canadian currency.
By pressing the Recalculate button (on the summary form or on the T5013 slip
form) the information entered in this area will be allocated among the partners
and posted to boxes 18, 20, and 22-29 of the T5013 slips according to each
partner’s share of net income (or loss).
Gross Income or Loss
These amounts are the gross income or losses for accounting purposes from the
financial statements.
Net Income or Loss
These amounts are the net income or losses adjusted for income tax purposes.
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Area D: Selected Data

This section sums up the selected information from the partnership’s financial
statements for the period covered by the partnership information return.

Entering Summary Information
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Area E: Miscellaneous Information, Page 1

Check each box to indicate a Yes response or leave blank for a No response. In
many cases, further information will be requested if the response is Yes.
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Additional Amounts for Allocation
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Entering Summary Information

8-21

The information entered in this area will be allocated among the partners and
posted to boxes 19, 21, and 30-45 of the T5013 slips according to each partner’s
share of net income (or loss).
Partners

Shows the name, Identification number, units or interest owned, and the
percentage share of each partner in the partnership.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.

8-22

T4 TimeSaver User Manual

T5018 Summary

Period Ending
Enter the date for the end of the period being reported.
Person to contact about this return
The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

Entering Summary Information
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More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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RL-1 Summary

Québec income tax
Enter the value of the total income tax withheld from all RL-16 slips, and all RL-2
slips.
Compensation Tax
Compensation tax applies only to listed financial institutions other than
corporations. If the company is not exempt from the compensation tax, remove
the check from the appropriate box. The wages subject to the compensation tax
are the totals from boss A and Q of the RL-1 slips.
Total
Once you have entered the sum of the QPP, income and compensation tax
remitted in box 26, the box 27 total will be calculated.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.
Page 2
Contains additional information required for the RL-1 Summary.

Entering Summary Information
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Contributions to health services fund (FSS)
In the Adjustments box, enter the value required to obtain the correct total
Salaries value. If the value contained in the box labeled Boxes A + Q is the
same as the total salaries, leave the Adjustments box with the default value of
0.00. In the Exempt box, enter any salaries and wages paid by a new
corporation and exempted from the contribution. You will need to attach a
completed copy of the chart found on page 2 of the Summary of Source
Deductions and Employer Contributions.
The amount subject to FSS is calculated, and the rate is applied based on the
formula described in the RL-1 guide.
Contribution to CNT
Enter the remuneration subject to contribution to the financing of the Commission
des normes du travail (CNT), as calculated on form LE-39.0.2-V. in the box
labeled Remuneration subject to contribution.
Contribution to FNF
Enter the value of the eligible training expenditures in the box so that the
contribution to the Fonds national de formation de la main-d’oeuvre can be
calculated.
Note that if the total payroll (sum of boxes A and Q) is less than one million
dollars, no contribution to FNF is required.
Page 3
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Contains additional information required for the RL-1 Summary.

Other Information
Enter the other requested information for the RL-1 Summary form on page 3.
Note that the number of slips listed should be the total number of RL-1, RL-2 and
RL-25 slips for the company, whether they were filed on paper, magnetic media,
or by internet.
Date printed
If the Relevé 1 Summary was previously printed, the date printed on the
summary will be recorded here. Otherwise this box will be blank.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.

Entering Summary Information

8-27

RL-3 Summary

Amount for which Relevé 3s not filed
You should manually total all amounts from RL-3 slips that were not submitted
because the amount was less than $50 and enter the total value in the box
labeled Amount for which Relevés 3s not filed.
Total amount of income of unknown users
You will need to calculate this value yourself by totaling the combined income
from all RL-3 slips that have "Unknown" for the recipient's name and address.
Page 2
Contains additional information required for the RL-3 Summary.
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RL-3 Summary Information
Enter the correct year for which the data applies.
The "Code" field refers to whether the Summary is an original (0), additional (1) ,
or amended (2) Summary. Enter the appropriate code.
If you are submitting RL-3 data on magnetic media, check the box and enter the
number of RL-3 slips which are being submitted in this manner.
Filer (payer or nominee)
Enter the filer ID number, filer branch number (if applicable), and the name and
telephone number of a resource person. The name and address of the filer will
be taken from the company information Identification tab.
Transmitter
Enter the ID number, transmitter number, name and address of the transmitter
company, and the name and phone number of a resource person.
Certification
When you create a new company, the title and phone number for the certification
section are copied from the New Company Defaults tab of the Setup menu.
You may edit them on the RL-3 Summary form if required.
Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

Entering Summary Information
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More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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RL-2 Summary

Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.

Entering Summary Information
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RL-25 Summary

Certification
The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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Chapter 9 – Producing Reports
See Appendix G for a table outlining the filing requirements for the slips and
summaries available with T4 TimeSaver.

Printing Slips
Select the desired type of slip from the Reports menu. Then select Slips from
this list of available reports. A dialog box will open, which will allow you to select
which slips you wish to print, the type of paper and the printer you wish to print
them on, and the number of copies you wish to print. The individual slips can
then be distributed to the employees or recipients and CRA.
Note that the unadjusted values will print on each of the T4 and Relevé 1 slips
unless all of the slips have been adjusted. You will be warned if some of the slips
are adjusted and others are not.
Companies
Select one of the three options listed:
· All (to print the slips for all companies in the current database),
· Current (to print the slips for only the current company), or
· Selected (to print the slips for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print slips
for using the Select, Unselect, Select All, and Unselect All buttons. When all
the required companies have been added to the selected list, click on Close.
Slips
Select one of the four options listed:
All (to print all the slips for the selected companies),
Amended only (to print only the amended slips for the selected companies),
Originals only (to print only the slips that have not been amended for the
selected companies), or
Selected (to print only the selected slips for the current company).
If you choose Selected, click on the Select button to get a list of the employees
for the current company. Choose which employees you wish to print slips for
using the select, unselect, select all, and unselect all buttons. When all the
required employees have been added to the selected list, click on close.
Copy & Printer Selection
Choose which copies of the slips you wish to print by checking one or more of the
boxes. The options will change, depending on the Type of Form you have
selected. See the Filing Requirements in Appendix G for details regarding the
printing and distribution of the various copies of the slips.
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Each copy selection has a separate printer selection. Accept the printer named
in the combo box or select another valid printer from the list.
Paper Source
Indicate manual feed or one of the paper tray options listed for the selected
printer.
Font
Make sure the Use selected fonts option is checked. Select the desired font from
the list. You can select a different font for each copy of the report.
Note: By selecting a different font, you may affect the font size and placement of
the printing. It is advisable to print a test form to determine whether alignment
has been affected by the change in font.
Type of Forms
Select one of the listed options:
Plain paper facsimiles (to print a facsimile copy of the slip on a laser or ink jet
printer) ,
Pre-printed laser forms (to print onto preprinted laser forms)
(Continuous dot matrix forms are no longer available in the T4 TimeSaver).
Sort Returns by
If you select "Sort returns by Company", T4 TimeSaver will print copies 2/3, copy
1 and then copy 4 for the first company, and then repeat for each remaining
company. If you select "Sort returns by Copy Number", all of the copy 2/3s will
print, followed by all of the copy 1s and finally all of the copy 4s.
Order of Slips
Choose the order in which you wish the slips to print from the given options. The
options will change, depending on the type of slip to be printed.
Options
Whenever a facsimile or pre-printed laser form is being printed, the option to
Pause between copies for paper change will be available. If this option is
checked, the program will prompt you to change from the paper for copy 2/3 to
copy 1 and then to copy 4 when appropriate.
You may elect to print inactive (nil) forms. These are slips that have all dollar
values set to zero. These slips will not print unless this option is checked.
For some forms you will have the option to print French instructions on copy
2/3. You may select this option for French speaking employees.

Producing Reports
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In some cases T4 TimeSaver may try to switch to a paper size that your printer
driver cannot accommodate. Checking the use default paper size option will
cause the program to use the paper size selected in Windows.
Some printer drivers allow printing closer to the bottom of the paper than others.
In some cases, the preprinted forms cannot be completed, because the particular
printer driver cannot print as close to the bottom of the form as is necessary. If
this is the case T4 TimeSaver will warn you that there is a problem and offer
some possible solutions. One of the solutions may be to check the force
printing to bottom option. When this option is selected, T4 TimeSaver will
attempt to change the paper size to a larger size to force the printer to print lower
on the page.
If you wish to have the employee number appear in the address field of the slip,
select the Print employee name followed by employee number option.

Print Alignment
Before beginning to print, you may wish to print a test page. If the printing does
not align correctly, click on the Adjust Margins button, and enter values that will
offset the printing and move it to the correct place.
Test Printer
This button will print a test page to your Windows default printer in order to
determine the maximum printable height for the printer.

Printing Summary Reports
Note that the T5013 summary and the T5014, T5015, and T5017 partnership
forms will print using the Adobe Acrobat Reader software. You will be able to
print the form for the current company only.
To print the Summary Form to be sent with the slips to CRA, select the
appropriate type of summary from the list in the Reports menu, and then choose
Summaries from the list of available reports. A dialog box will open which will
allow you to select which Summary forms you wish to print, the type of paper to
print them on, the printer you wish to print them on, and the number of copies
you wish to print.
Note that the summary will reflect the unadjusted values from each slip unless all
of the slips have been adjusted. You will be warned if some of the slips are
adjusted while others are not.
Companies
Select one of the three options listed:
· All (to print the Summary reports for all companies in the current database),
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· Current (to print the Summary report for only the current company), or
· Selected (to print the Summary reports for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print a
Summary Report for using the Select, Unselect, Select All, and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.
Slips
Select one of the options listed:
· All (to include all the slips in the Summary report for the selected companies),
· Amended only (to include only the amended slips in the Summary report for
the selected companies), or
· Originals only (to include only the non-amended slips in the Summary report
for the selected companies).
Copy & Printer Selection
Select one or more of the options listed. The options will change, depending on
the Type of Form you have selected. See the Filing Requirements in Appendix
G for details regarding the printing and distribution of the various copies of the
Summaries.
Each copy selection has a separate printer selection. Accept the printer named
in the combo box or select another valid printer from the list.
Paper Source
Accept the paper tray named in the combo box or select another valid paper tray
option from the list for the selected printer.
Font
Make sure the Use selected fonts option is checked. Select the desired font from
the list. You can select a different font for each copy of the report.
Note: By selecting a different font, you may affect the font size and placement of
the printing. It is advisable to print a test form to determine whether alignment
has been affected by the change in font.
Type of Forms
Select one of the options listed:
· Plain paper (to print a facsimile copy of the form on a laser or ink jet printer),
· Pre-printed laser forms (to print onto preprinted laser forms)
Sort Returns by
If you select "Sort returns by Company", T4 TimeSaver will print all of the
summaries for the first company and then repeat for each remaining company. If
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you select "Sort returns by Copy Number", the copy 1s for all the companies will
print first, followed by all of the copy 2s, etc.
You may also choose to print the current date, or change to another date if
appropriate.
Options
Whenever a laser form is being printed, the option to pause between copies for
paper change will be available. If this option is checked, the program will prompt
you to change paper between copies 1 and 2 and between copies 2 and 3.
You may elect to print inactive (nil) forms. These are slips that have all dollar
values set to zero. These slips will not print unless this option is checked.
If you have been sent pre-printed summaries from CRA, they may already
contain the company name, address, and business number as well as the code
for the applicable tax centre. In this case you would select the name/address
preprinted option to suppress duplicate printing of this information.
In some cases T4 TimeSaver may try to switch to a paper size that your printer
driver cannot accommodate. Checking the use default paper size option will
cause the program to use the paper size selected in Windows.
Some printer drivers allow printing closer to the bottom of the paper than others.
In some cases, the preprinted forms cannot be completed, because the particular
printer driver cannot print as close to the bottom of the form as is necessary. If
this is the case T4 TimeSaver will warn you that there is a problem and offer
some possible solutions. One of the solutions may be to check the force
printing to bottom option. When this option is selected, T4 TimeSaver will
attempt to change the paper size to a larger size to force the printer to print lower
on the page.
Some of the pre-printed forms from CRA contain fields that are composed of
frames; one for each character in the field. It is not necessary to follow these
frames when typing or printing using a printer since the frames are ignored by the
scanning devices used to read the data. However, if you would like to have the
data stretched to fit one character into each frame you can select the fit
numbers/text in frames option.
Print Alignment
Before beginning to print, you may wish to print a test page. If the printing does
not align correctly, click on the Adjust Margins button, and enter values that will
offset the printing and move it to the correct place.
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Test Printer
This button will print a test page to your Windows default printer in order to
determine the maximum printable height for the printer.

Printing Adjustment Reports
A report showing all the adjustments made for each employee can be produced
for the T4 and RL-1 slips. To generate this report, select T4 or RL-1 from the
Reports menu. Then choose Adjustments from this list of available reports. A
dialog box will open which will allow you to select the companies for which you
wish to print T4 Adjustment Reports and the desired printer.
Companies
Select one of the three options listed:
· All (to print the Adjustment report for all companies in the current database),
· Current (to print the Adjustment report for only the current company), or
· Selected (to print the Adjustment report for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print the
Adjustment Reports for using the Select, Unselect, Select All, and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.
Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of this chapter.
Order of Slips
Select one of the options listed below:
· Order by selected field (lists employees sorted by selected field), or
· Order in data entry sequence (lists employees in the order they were
entered).
Copies of Report
Type in the number of copies you require.
Output Report to
Select one of the options listed below:
· Display (shows the report on your computer monitor), or
· Printer (prints the report on paper).
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Options
Select one of the options listed below:
· Detailed report which shows the entered and adjusted values for each
employee’s CPP/QPP, EI, and tax deduction, as well as a Summary for the
company, or
· Summary report which lists the total adjustments for each company.
Current Printer
This command button accesses the Print Setup dialog box, where you can select
the default printer for printing Adjustment Reports and the source (paper tray,
manual, etc.) of the paper.
Note: An asterisk beside a S.I.N. indicates that the S.I.N. value is invalid. (See
S.I.N. validation in Chapter 6).

Printing Edit List Reports
A complete edit listing of all the slips can be produced for all types of slips. To
generate this report, choose the type of slip from the Reports menu, and then
select Edit List from the list of available reports. A dialog box will open which will
allow you to select the companies to print an Edit List Report for and the printer
to print the reports on.
Companies
Select one of the three options listed below:
· All (to print the Edit List report for all companies in the current database),
· Current (to print the Edit List report for only the current company), or
· Selected (to print the Edit List report for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print the
Edit List Reports for using the Select, Unselect, Select All, and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.
Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of this chapter.

Fields to print
Select one of the two options listed below:
· All (to include all the fields available on the slip), or
· Selected (to print only those fields which you select).
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If you choose Selected, click on the Select button to get a list of the fields
available for the current slip. Choose the fields you wish to print on the Edit List
Reports by using the select, unselect, select all, and unselect all buttons. When
all the required fields have been added to the selected list, click on close.
Order of Slips
Select one of the options listed below:
· Order by selected field (lists employees sorted by selected field), or
· Order in data entry sequence (lists employees in the order they were
entered).
Copies of Report
Type in the number of copies you require.
Output Report to
Select one of the options listed below:
· Display (shows the report on your computer monitor), or
· Printer (prints the report on paper).
Options
Select the format you would prefer (either table style or memo style) and check
one or more of the other options listed below, if appropriate:
· Include addresses
· Include inactive slips. (An inactive slip is one which has all dollar amounts
set to zero.)
· Use legal paper (8½ x 14), and
· Landscape orientation
Current Printer
This command button accesses the Print Setup dialog box where you can select
the default printer for printing Edit List Reports and the source (paper tray,
manual, etc.) of the paper.
Note: An asterisk beside a S.I.N. indicates that the S.I.N. value is invalid. (See
S.I.N. validation in Chapter 6).

Printing the Company Summary Report
A Company Summary Report is a listing of the companies in the current
database with the number of active and inactive slips of each type. Select
Company Summary Report from the Reports menu to generate this report. A
dialog box will open which will allow you to select which companies to include, the
number of copies to be printed, the printer to use, and whether to print the report
or display it on the computer screen.

Producing Reports
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Companies
Select one of the three options listed below:
· All (to print the Summary reports for all companies in the current database),
· Current (to print the Summary report for only the current company), or
· Selected (to print the Summary reports for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print a
Summary Report for using the Select, Unselect, Select All, and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.
Or click on Filter to select the companies to include by data entry status, printing
status, company category, or with a specific type of slip. See the section entitled
Using Filters at the end of this chapter.
Copies of Report
Type in the number of copies you require.
Output Report to
Select one of the options listed below:
· Display (shows the report on your computer monitor), or
· Printer (prints the report on paper).
Options
Decide whether or not you want to include the address information.
Current Printer
This command button accesses the Print Setup dialog box where you can select
the default printer for printing Company Summary Reports and the source (paper
tray, manual, etc.) of the paper.

Using Filters
The Filter button allows you to select which companies to include in a report
based on data entry status, printing status, magnetic media status, or company
category. The report generated will contain information for the companies that
meet the criteria you select, all other companies will be filtered out. When you
click on the Filter button, the Select Companies by Filter window appears.
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Data Entry Status
Check this box if you want to filter by whether or not the data entry is complete.
Select one of the options listed.
Printing Status
Check this box if you need to filter by whether or not the slips and summaries
have been printed. Select one of the options listed.
Magnetic Media Status
Check this box if you want to filter by whether or not the slips for the company
have been filed by magnetic media. You can also filter out the companies by the
date that their magnetic media was processed. This option only appears when
reports are being entered for returns for which magnetic media filing is supported.
Slip Type
Check this box if you wish to select one type of slip to report on. Then enter the
type of slip for which you want a report (“T4", “T4A”, “T5", “T4ANR”, “NR4",
“T4PS”, “T4AP”, “T4ARCA”, “T5013”, “T5018”, “R2”, “R15”, “R17”, “R25” or
“T1204”).
Company Category
Check this box if you wish to select one company category to report on. Then
type in the company category name.
Filter Applies To
This option only appears when printing the Company Summary Report. You
need to indicate which type of return the data entry status and printing status
refers to. Once you have made your selections, click on the Set Filter button.
You will be told the number of companies that meet the criteria you have
outlined. Confirm the selection and the company names will appear in the
companies box.

Filing by Magnetic Media
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Chapter 10 - Filing by Magnetic Media or Internet
NOTE: This feature is only available in T4 TimeSaver Plus

General information
NOTE: As a user of T4 TimeSaver, the requirement for you to submit a test file
with the Ministère du Revenu is waived because ELM Computer Systems
submits test files and receives approvals for the output of T4 TimeSaver from the
appropriate government departments each year. However, if you prefer to
submit your own test files, you may do so by following the instructions in the
appropriate guides.
Please note that returns for employers filing over 500 returns are required by
CRA to be filed on magnetic media.
Filing on magnetic media is to your advantage because it reduces your printing
costs as well as the time spent handling paper. The program generates all the
components required for a complete magnetic media submission:
• diskette, CD or DVD containing the T4, NR4, T4A, T4A-NR, T4A(P), T5, T1204,
RL-1, RL-2, RL-3 or RL-25 information and transmitter identification (CRA no
longer accepts submissions on multiple diskettes)
• Description of Magnetic Medium (ED-400-V, formerly OPR-400-V) for Quebec
returns
You may include returns for any number of companies when creating a magnetic
media submission. Approximately 2,000 slip and summary records will fit on a
single 1.44Mb floppy diskette, while about 80,000 slip and summary records will
fit on a CD and an even greater number on a DVD (depending on the type of
DVD media you are using). Each diskette counts as a single submission. If you
choose to submit your returns on CD or DVD a file will be created on your hard
drive which you may then copy to the appropriate drive using your own CD or
DVD writing software. NOTE: You must have access to a CD or DVD writer to
use this option.

Instructions for Federal Returns
The following instructions are provided here for convenient reference. For
complete details, obtain the CRA publications T4028 (for T4s, T4As, and T4ANRs), and T4031(E) (for T5s and NR4s), both entitled Computer Specifications
for Data Filed on Magnetic Media.
1. A magnetic media submission may contain only one diskette, CD or
DVD. If you have multiple submissions each submission must be
submitted with its associated paper-work in a separate envelope.
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Multiple envelopes may be taped together for simplified mailing.
2. You may file original, amended or cancelled returns on magnetic
media. You will be required to submit each type of return individually.
Prepare corrections in accordance with the instructions below.
3. If you are submitting returns partially on magnetic media and partially
on paper forms you must complete a separate summary for the portion
on paper. Both the magnetic media and paper portions of the return
should be submitted to the Magnetic Media Processing Team.
4. As noted earlier, filing on magnetic media eliminates the need to file
paper copies of the summaries and slips with CRA. Do not send CRA
paper copies of any returns that have been filed on diskette.

Shipping Instructions
A complete magnetic media submission should be labeled ‘MAGNETIC MEDIA
FILER’ in clear, bold print and sent by courier or mail to the Magnetic Media
Processing Team. You may include a number of submissions in a single
shipment, as long as each submission is in a separate envelope. If there is more
than one diskette in a set, each must be labeled and numbered in sequence (i.e.
1 of 3, 2 of 3, 3 of 3, etc.).
Making Corrections
If it becomes necessary to make changes to the slips submitted on diskette
please consult the following instructions.
If the submission has not yet been sent to CRA you may choose to simply correct
the returns and recreate the diskette(s). If you do not wish to recreate the
diskette(s) you may prepare amended slips and summaries and include them
with the diskette submission.
If the corrections are being made to a submission that has already been sent to
the Magnetic Media Processing Team you are required to fill out a change form
to be included with your corrections. Please contact the Magnetic Media
Processing Team for further information.
Further Information
If you have further questions regarding the specifics of your magnetic media
submission, please contact the Magnetic Media Processing Team.
Magnetic Media Processing Team
Revenue Canada, Taxation
Ottawa Taxation Centre
875 Heron Road
Ottawa, Ontario
K1A 1A2
Telephone: 1-800-665-5164
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Instructions for Quebec Returns
The following instructions are provided here for convenient reference. For
complete details, obtain from the Ministère du Revenu the publications entitled
Guide for Filing Data on Magnetic Media, General and technical information, and
the associated guides for the type of slip you are filing.
Please note that returns for employers with fewer than 15 returns must not be
submitted on magnetic media. Returns for any employers with over 500 returns
are required by the Ministère du Revenu to be submitted on magnetic media.
Each organization filing RL magnetic media on their own behalf or on the behalf
of others must request a transmitter number and a set of serial numbers from
Ministère du Revenu before producing the magnetic media returns.
1. If you submit RL-slip data for more than one filer, you must provide the
Ministère du Revenu with a list of the names and the active
identification and file numbers of all filers for whom you are submitting
data for the year. You must also specify the type and number of RL
slips being filed on each filer's behalf.
2. A magnetic media submission may not contain multiple sets of media.
A submission can contain only one type of return, but may contain
returns for multiple companies.
3. T4 TimeSaver enables you to process original, amended and cancelled
RL-slips on magnetic media.
4. Filing on magnetic media eliminates the need to file paper copies of the
slips with the Ministère du Revenu. However, paper copies of
summaries must be sent under separate cover to the address given
in the guides for filing the returns. Do not send them to the address
that you use for data filed on magnetic media.
Shipping Instructions
1. The following information must be clearly marked on each diskette, CD or
DVD:
a. the type of RL data (for example, RL-1);
b. the transmitter's name and transmitter number;
c. the sequence number of the magnetic medium (for example, 1 of 3);
d. the name and telephone number of the resource person.
2. Enclose a completed copy of form ED-400V (formerly OPR-400-V),
Description of Magnetic Medium, for each diskette, CD or DVD set you
submit.
3. Send your package to the following address:
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Groupe de promotion de l’EDI et d’acquisition
des données électroniques
Direction générale du traitement et des technologies
Ministère du Revenu
3800, rue de Marly, secteur 2-2-0
Sainte-Foy (Québec) G1X 4A5

Further Information
If you have further questions regarding your magnetic media submission, please
contact:
M. Yvan-Denis Veilleux
Direction générale du traitement et des technologies
Ministère du Revenu
3800, rue de Marly, secteur 2-2-0
Sainte-Foy (Québec) G1X 4A5
Telephone: (418) 652-5281
Fax: (418) 646-0713
E-mail: yvan-denis.veilleux@mrq.gouv.qc.ca

Setting up the Magnetic Media Transmitter Record Defaults
During setup you should complete the Magnetic Media tab of the Setup menu if
you plan to submit returns on magnetic media. Much of the information required
by T4 TimeSaver for magnetic media processing is contained there.
To access magnetic media processing, choose the type of slip required from the
Reports menu and then Magnetic Media. Note that magnetic media filing is only
available for T4, NR4, T4A, T4A-NR, T4A(P), T5, T1204, RL-1, RL-2, RL-3 and
RL-25 returns.
The magnetic media dialog box will open and give you a number of options:
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Companies
Select one of the three options listed below:
· All (to create magnetic media output for all companies in the current
database),
· Current (to create magnetic media output for only the current company), or
· Selected (to create magnetic media output for the companies you select).
If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to create
magnetic media output for using the select, unselect, select all, and unselect all
buttons. When all the required companies have been added to the selected list,
click on close.
Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of Chapter 9.
Return types
Select on of the two options listed below:
· Current (to create magnetic media output for only the current slip type), or
· Selected (to create magnetic media output for the slip types you select).
If you choose Selected, click on the Select button to get a list of the slip types for
the selected company (or companies). Choose the slip types you wish to create
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magnetic media output for using the select, unselect, select all, and unselect all
buttons. When all the required slip types have been added to the selected list,
click on close.
Options
Choose the media by which the return(s) will be submitted to the CRA or MRQ.
Your options are: Internet, CD, DVD or Diskette. If you choose to submit your
returns on CD or DVD a file will be created on your hard drive which you may
then copy to the appropriate drive using your own CD or DVD writing software.
NOTE: You must have access to a CD or DVD writer to use this option. If
you choose to submit your returns on diskette select the letter of the disk drive
(either A or B) you wish to send the output to. Be sure to place a blank formatted
diskette in the drive you selected.
If you are submitting returns over the internet please remember that only the
following returns may be submitted over the internet:
· CRA: T4, T4A, T5, NR4, T4ANR and originals only of the T5018
· MRQ: RL-1, RL-2, RL-3 and RL-25
Edit Transmitter Information
Pressing this button will allow you access to the information stored on the
Magnetic Media tab of the Setup menu. You can add missing information or
edit existing data. Clicking on the OK button will return you to the magnetic
media dialog box.
File Slip Type
The data type (original or amended/cancelled) that will be filed is displayed here.
Current printer
This area displays the current printer. The Select command button accesses the
Print Setup dialog box where you can select the default printer for printing
Magnetic Media Reports and the source (paper tray, manual, etc.) of the paper.
Process
Pressing this command button will begin the processing of the magnetic media.
You will be prompted to insert formatted diskettes when needed, and given a
filename to put on the diskette label. The magnetic media transmittal reports will
print automatically once the processing is complete.
Remove Serial #s (RL magnetic media only)
Use this function to remove previously assigned serial numbers. This should only
be done if the returns have not yet be submitted to Ministère du Revenu du
Québec and one of the following is true:
1. You elect not to submit by magnetic media after processing has been done.
2. The range of numbers used was not the range assigned by Ministère du
Revenu du Québec.
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3. Errors or omissions were discovered in the data so the returns must be
reprocessed before submitting.
Set Serial #s (RL magnetic media only)
The Ministère du Revenu du Québec requires each transmitter to use a unique
set of serial numbers for RL-1 and RL-3 magnetic media. You must contact them
to obtain your numbers (as well as your transmitter number). This button allows
you to enter the staring number, or change the number at any time. It is your
responsibility to ensure that the starting number is correct.

Internet T4 Filing
T4 TimeSaver is able to utilize CRA’s URL for internet filing of the following
returns:
· CRA: T4, T4A, T5, NR4, T4ANR and originals only of the T5018
· MRQ: RL-1, RL-2, RL-3 and RL-25
The related websites are listed below:
http://www.CRA-adrc.gc.ca/tax/business/t4internet/filenow-e.html
Select the third filing option (T4 Internet File Transfer (XML) or go to the following
website.
https://apps.cra-arc.gc.ca/ebci/leb0/upload/T05iDisclaimerRender-e
which will take you to a page entitled: “Disclaimer - T4 Internet File Transfer
(XML).” You will be required to read and agree to CRA terms and conditions
disclaimer before you can enter the Business Number and Web Access Code for
the company for which you are filing an internet T4 return. (If you have not
th
received your Web Access Code by January 9 contact the CRA support staff at
1 866 322 7489 to have one issued to you.)
Once this information has been entered and validated you will be prompted to
upload a file containing the company data in XML format to the CRA website.
This process must be repeated for each company for which you wish to file T4
returns over the internet due to the fact that the CRA Internet Filing protocol is
currently under development.
T4 TimeSaver will save all XML files in the following format:
COMPANY_NAME_XXX.XML
where “COMPANY_NAME” is the name of the company for which the file has
been created with all space characters replace by an underscore character;
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“XXX’ is a sequential number applied by T4 TimeSaver to ensure that older files
are not overwritten, and “XML” is the default file type designator required by CRA.
T4 TimeSaver Plus is able to returns for multiple companies over the internet in
a single file which can be no larger than 610kb in size. As in this case you would
be acting as an agent for multiple companies you must use your own Business
Number and Web Access Code to access the CRA website.
T4 TimeSaver Basic is limited to submitting returns for single companies over
the internet. As above, the file can be no larger than 610kb in size.

Internet Filing to Ministère du Revenu du Québec
To file a Revenu du Québec submission via the internet, go to the following
website and follow the directions for setting up a use word and password.
http://www.revenu.gouv.qc.ca/eng/services/sgp_rl_internet/index.asp
Then follow the filing directions given.
You must follow the naming convention below for submissions to the MRQ:
AAPPPPPPSSS
Where:
AA denotes the year of the submission (for 2005 AA = 05)
PPPPPP denotes the transmitter number
SSS denotes the sequence or submission number (beginning at 001 and
incrementing by 1 for each subsequent submission)
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Chapter 11 - Tools
Transfer Companies
Use this function to transfer one or more companies from the current database to
another database. Set the destination database by selecting an existing
database or creating a new one. Indicate which company(ies) you wish to
transfer using the Select, Unselect, Select All, and Unselect All buttons. If the
Remove Company from Source Database option is not checked, the company
information will remain in both the current database and the destination database,
otherwise it will be available only in the destination database.

Merge Companies
Use this function to merge two companies as a third company. The companies to
be merged can be selected from any database accessible to T4 TimeSaver. The
resulting company, containing the merged data, must not already exist in the
database in which it will be stored, which can be any database accessible to T4
TimeSaver.

Correct Contact Information
Use this function to correct the contact information for one, all, or selected
companies. The option is provided to correct the company summary contact
information as well.
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Zero Out Slips
Use this function to clear the dollar values from slips while maintaining the
existing employee names and addresses.

Select the all companies in the database, just the current database, all
companies with the entered company category, or select individual companies.
Select either all slips of all types, or select the slip type from the list.
Once the selections have been made, click the Proceed button to complete the
process.

Database Repair
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The database repair routine in T4 TimeSaver performs two functions. It
compacts databases to save space and it recovers from certain types of file
corruption caused by power failures, software problems, many hardware
problems, and most common types of operator errors. However, certain
situations such as physical damage to the data storage media (hard drive or
disks), or inadvertent erasure of files cannot be rectified by database repair
routine.
Warning:
IN NO CASE SHOULD YOU RELY SOLELY ON THE DATABASE REPAIR
ROUTINE IN THIS SYSTEM TO PROTECT YOUR FILES FROM ACCIDENTAL
ERASURE OR ANY OTHER LOSS OR CORRUPTION. YOU ARE
RESPONSIBLE FOR ENSURING THAT ADEQUATE BACKUP COPIES OF ALL
YOUR FILES (BOTH DATA AND PROGRAMS) ARE MADE ON A REGULAR,
SYSTEMATIC BASIS.
When to run Database Repair
The system constantly checks the validity of its files, and if it detects any
corruption it will report it. This could occur if you had turned off the computer (or
re-booted) without exiting T4 TimeSaver or had a power failure. If you run out of
disk space you may also experience some problems with the data. In this case,
you should free up some disk space before proceeding with the database repair
routine.
If you get an error message about a corrupted database, you should run the
Database Repair option in the Tools menu to attempt to correct the damage.
Before using this tool it is advisable to make a backup copy of your database.
You can copy the database to a floppy diskette, or to another hard drive.
Select the Database Repair option from the Tools menu. Choose the current
database or selected database and click Start. If you have chosen selected
database, highlight the correct database directory and name from the list of
available databases. The process will begin as soon as you click on OK. You will
be informed when the repair is complete. Any data that cannot be fixed will be
discarded. You can then open the database again, and continue as usual.
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Convert Last Year’s Database

This function converts a “.t03" database into a “.t04" database of the same name.
Use this function to maintain the company and employee data.
Options
You can choose to set all dollar values to zero and to remove any “amended”
markers by checking this box. Otherwise, all dollar values will be maintained and
amended slips will still be labeled amended. Check in the appropriate box(es) if
you want to clear the CPP exemption fields, the EI exempt fields, the T5013
Details boxes and/or to initialize the partnership forms.
Select Source Directory
Choose the drive and directory that contains the 2004 databases you wish to
convert. The T4 TimeSaver will automatically find and list all the files having a
“.t03" extension. The “.t03" databases will not be deleted.
Select T4 TimeSaver file(s) to be converted
Highlight the file(s) you wish to convert. T4 TimeSaver will create a new file with
the same name but a “.t03" extension in the same directory as the original 2004
database. Only the highlighted files will be converted when the Convert button is
clicked.
Select Destination Directory
Choose the drive and directory in which you wish to store the 2005 database.
The directory can be the one containing the 2004 database or you can create a
new one each year.
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Import
Import from Text File
Note: Appendix J contains important information regarding Importing from text files.

If you have information in a payroll package or another tax slip preparation
software product, and you would like to import this information into T4 TimeSaver,
you can do so if the software allows you to export to a spreadsheet or text file.
You can import company, T4, T4A, T5, RL-1, RL-2, RL-3, RL-15, RL-25, NR4,
T4A-NR, T5013 and T5018 slip information.
Creating an import file
The files that T4 TimeSaver imports are tab-delimited text files. (The format of
the text file is quite similar to the format used by QuickBooks for its export and
import files.) The file is structured with keywords in capital letters that serve as
row and column headings. The keywords that appear at the beginning of each
row identify the type of information in that row. For example, the keyword T4
indicates that the row contains data about a T4 slip.
Generally, rows that begin with the same keyword are grouped together. For
example, all of the T4 entries appear as a single block of rows in the file. Each
block, in turn, has its own column headings that appear in capital letters in the
cells of the first row in the block. The column headings identify the type of
information that each column in the block contains.
There is one important exception to the rule that rows are grouped by keyword. If
your import file includes both company and slip information, the slip information
must follow immediately after the company to which it applies. For example, if
your import file includes two companies with their associated T4 data, the blocks
of information would be in sequence as follows:
Company 1
T4's for Company 1
Company 2
T4's for Company 2
You may optionally choose not to import company information, but to add the
company information using T4 TimeSaver. The Import function will prompt you
for the company to import slip information into. If you select the company this
way, the import file may only contain slips for that company.
The best way to create or view an import file is to use a spreadsheet program -that way, you will see the data laid out into rows and columns. If you do not have
a spreadsheet program, you can also create an import file in a word processor.
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Instructions
1. Open the spreadsheet that contains the data.
2. Move the contents of all the cells in your spreadsheet one column to the right
so that the first column is blank.
3. Move the contents of all the cells down by one row so that the first row is
blank.
4. Check the structure of the spreadsheet. If it contains more than one type of
information, for example, company information and T4 information, make sure
that each type of information has its own block in the spreadsheet. The blocks
should follow each other vertically.
5. In the first cell in the blank row above each block of information, enter one of
the keywords shown in this table. Be sure to include the exclamation point (!).
Enter this text . . .

If the block contains...

!COMPANY
!T4
!T4A
!T5
!T4PS
!NR4
!T4ANR
!T5013
!T5018
!RL2
!RL15
!RL17
!RL25

Company information
T4 and/or RL-1 slip information
T4A slip information
T5 and/or RL-3 slip information
T4PS information
NR4 information
T4A-NR information
T5013 (Partnership) information
T5018 information
RL-2 information
RL-15 information
RL-17 information
RL-25 information

For example, if the spreadsheet contains a company followed by its T4 slips, the
structure of the spreadsheet would be as follows:
!COMPANY
[Company information]
!T4
[List of employee’s names, addresses, gross pay, etc.]
6. Fill in the remaining cells of the first column with the keyword you entered in
the first row for each information block. This time, omit the exclamation point. In
our example, the first column would look like this:
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!COMPANY
COMPANY
!T4
T4
T4
T4
[etc.]
7. Complete the first row for each block of information by adding the headings
that T4 TimeSaver expects to find for that type of information. (See Appendix J
for details about headings for company and slip information.) For example, the
first row for a list of T4 slips might look like this:
!T4

NAME ADDRESS1 ADDRESS2 CITY PROV POSTAL SIN (etc.)

8. Make sure that the content of the columns in each block matches the
headings you just added. For example, if the city and province are in one
column, you need to move the province to the PROV column and the city to the
CITY column. Our sample spread sheet would look something like this:
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9. Save the spreadsheet as a tab delimited text file. (The columns must be
separated by tabs.) Add a .TXT extension to the filename. The .TXT extension is
not required; however, if you use the extension, T4 TimeSaver locates the file
more quickly.
10. Start T4 TimeSaver. From the Tools menu, choose Import from Text File and
enter the name and path of the file you just created. Click OK.
What happens
T4 TimeSaver adds the data to the database you currently have open and
updates summaries as needed. For example, if you have imported a list of T4
slips, T4 TimeSaver updates the T4 summary with the totals of the slips.

Change T4 Adjustment Options
This tool enables you to change the T4 adjustment options for all companies or a
group of companies (selected directly from a list or by their category code).

Import from Magnetic Media File
If you have information in a magnetic media file, and you would like to import this
information into T4 TimeSaver this tool allows you to do so. You can import
company information as well as employee information for any slip type currently
supported by T4 TimeSaver’s Magnetic Media function.

Import from Payroll (Separate Module)
If you have purchased the Import from Payroll module you can use this function.
The first time you use the module, you will need to enter the password you have
been provided with.
Follow the instructions from your payroll package for submitting your T4s either by
the internet or as a magnetic media submission. In either case, save the created
file on your local computer.
Select Import from Payroll from the Import subdirectory of the Tools menu. The
following window will appear.
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Browse to the drive and directory where you saved the T4 submission file and
highlight the correct file. Select the appropriate Company Selection option, and
select the company if required. Click the Start Import button to import the data.

Export
The Export tool permits you to create a list of employee names and addresses to
a quote-comma delimited text file. You may select to export data from a single
company or a group of companies for any or all types of slips. This list may then
be imported into any program capable of opening quote-comma delimited files for
further processing.

Usage Analysis
The Usage Analysis tool can scan the various storage media attached to your
computer for T4 TimeSaver databases and display (or optionally print) a report
showing a list of all databases, companies, and types of slips that have been
entered into T4 TimeSaver. You can specify any combination of storage media to
scan for this report. Please note that the Usage Analysis tool will take several
minutes to complete on larger hard drives and over a network connection.

Calculator
Select Calculator from the Tools menu to open a window containing a calculator
which can be used for simple mathematical calculations.

Edit Settings
T4 TimeSaver uses .ini files to store configuration data. It may occasionally
become necessary to view and/or edit these files directly. Under the supervision
of a T4 TimeSaver Technical support specialist you can make use of Edit Settings
from the Tools menu to examine these files and make any necessary changes.
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Chapter 12 – Appendices
Appendix A - Data Backup
Routine backup procedures are essential to protect against data loss or
corruption in any computerized system. The best time to make a backup copy is
just before you turn the computer off at night. Do not backup your data onto
existing backup disks! If you should have a power failure while doing the backup,
you would lose your previous backup as well.
Backup for Floppy Disk Users
Use Explorer to make a copy of your data disk(s). Access Window Help or your
User Manual for further information. You should also have a backup copy of your
T4 TimeSaver installation disks.
Backup for Hard Disk Users
Copy the database to a floppy disk or separate hard drive using the DOS copy
command or Windows Explorer. The current database name appears in the very
top bar of the T4 TimeSaver window. The database will be in the same directory
as the program unless you specified otherwise when you created the database.
Be sure to close the database before attempting to back it up.
Restoring Data Files
Copy the stored backup of the database back to the working directory using the
DOS copy command or Windows Explorer.
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Appendix B - Technical Notes
Data Storage
T4 TimeSaver stores the data you enter in MS Access database files having the
extension ".t05". The company information is stored within the database in a
table called "Company", one record per company. There is also a table within the
database for each type of slip and Summary form. Data is stored in these tables,
one record per employee, and connected to the company information by a
company number assigned by the system.
The file T4W05.INI is stored in the same directory as the program and, among
other things, stores the authorization number. There will be additional file(s)
containing various user and machine related information also stored in the
working directory. If you have the single user version of T4 TimeSaver the file
will be named SINGLEYY.INI, where YY is the 2 digit year of the program. If you
have the network version of the program, there will be a separate file for each
user and the files will be named userYY.INI, where user is the user name entered
when starting T4 TimeSaver and YY is the 2 digit year of the program.
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Appendix C - Common Problems
1. "I get the message 'Company is locked by user
', but there are
no other stations using the T4 TimeSaver." or “The user named is not
currently using the program.”
This problem typically occurs when a database is left open after the program is
finished with it. If you are sure that the user being named is not using T4
TimeSaver already and that the company is not in use at another workstation, you
can answer “Yes” and unlock the company. If this does not solve the problem,
select Unlock all companies from the Company menu.
2. "The system is not calculating CPP properly. How do I enter the number
of pensionable weeks?"
This is one of the most common problems encountered by users of the T4
TimeSaver. Most likely, the problem stems from a failure to properly set up the
adjustment options. Access the company profile by selecting Edit company
information from the Company menu. Then select the T4 Adjustment Options
tab. There are two adjustment options involving CPP:
Adjust CPP if over maximum or under minimum
Adjust over/under paid CPP to tax based on number of pensionable weeks. (See
information in Chapter 7 Adjusting T4s and Relevé 1s for details)
The first option provides only a rough adjustment. It will either adjust CPP up to
the minimum or down to the maximum. If it falls in between these two, it will not
be changed. This option was implemented for situations where it is not desirable
to enter the number of pensionable weeks on each T4 slip. Because the system
does not have the number of weeks available to calculate prorated CPP
exemptions (if any), it must assume that there is no exemption. The calculated
CPP may therefore be higher when this option is used.
The second option requires you to enter the number of pensionable weeks on
each T4 slip, defaulting to the value entered for this option. Thus the program
has enough information to calculate prorated exemptions, and a more exact
adjustment results.
3. "When I print to pre-printed laser forms, the printing doesn't line up."
From the printing dialog box click on the Adjust Margins button. Enter positive or
negative values into the spaces provided under the headings "Vertical" and
"Horizontal". Positive values will move the printing down or to the right, while
negative values will move the printing up or to the left. You can indicate different
adjustments for each type of form listed.
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4. "EI insurable earnings is not printing even when I have entered a value in
Box 24."
If the EI insurable earnings is equal to gross pay or if it is equal to zero, CRA
Taxation asks that the EI insurable earnings not be printed, leaving Box 24 blank
in such cases. This is not a problem with T4 TimeSaver and we have checked
with CRA Taxation to ensure that the system is functioning properly.
5. “I have installed an update but the new features do not appear to be
available or functioning”
Check the version number of the T4 TimeSaver you are running by selecting
About T4TimeSaver from the Help menu. Make sure that the revision number
and date correspond to the update you have installed. If it is not, the most likely
problem is that you have installed the new version of the program into a different
directory than you did the first time. Run the update program again and select the
appropriate installation directory. Also, if you are starting the program from an
icon on your desktop, make sure that this shortcut is pointing to the correct
location. Alternatively, in a network environment, you may have some
workstations where the program was installed to a local hard disk. In this case,
the update program will have to be installed on the workstation’s local hard disk
as well. If none of the previous suggestions resolve the problem please ensure
that all users have exited the T4 TimeSaver and try installing the update once
again.
6. “I get error messages when I try to import my data from a text file”
The format of the text file must be exactly correct for the T4 TimeSaver to be able
to read and interpret the data. Make sure there are no blank rows or columns.
Try removing all columns with the heading “NULL”. Also, try selecting the data
cells from the top left to the bottom right, copying them and pasting them into a
new spreadsheet. Save this new spreadsheet as a tab delimited text file and try
the import from text function again.
7. “I get the message, ‘Cannot execute external program regedit.exe’ when
installing the program.”
The installation program needs to be able to find the file regedit.exe. It is
normally in your Windows directory. The solution is to make sure that regedit.exe
is in the Windows directory and that there is a path set to that directory. The path
is usually set in the autoexec.bat. See your systems administrator for help if
needed.
8. “My computer hangs when I start up T4 TimeSaver” or “My computer
hangs when I start up the program and enter the user name”
This indicates that the file USERYY.MDB is likely damaged. You can delete the
files USERYY.MDB and USERYY.BK*. You will then need to set up the user
names again. If you have a large number of users, you may wish to attempt
repairing the USERYY.MDB database. To do this, rename USERYY.MDB. Then
startup T4 TimeSaver. Select Repair Database from the Tools menu and point to
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the renamed file. Once it is repaired, you can rename it back to USERYY.MDB.
(YY indicates the two digit year of the program.)
9. “I get the message, ‘The OLE system files are in-use and cannot be
updated. This installation must restart Windows to update OLE before it
can continue. Press Yes to restart Windows and continue the installation,
or press No to exit the installation.’ when installing the program.”
This message is typically displayed when you are installing to a network directory
on a Novell network (although similar messages may be displayed if you are
installing to other network operating systems) and you do not have sufficient
rights to modify the contents of the network directory. To resolve the problem log
on to the network as an administrator and run the installation program again.
10. Other Problems
a) Miscellaneous data problems:
· run the Database Repair... found in the Tools menu on your data.
b) Miscellaneous printing problems:
· turn both the computer and the printer off, wait a minute, and turn them both
on again.
· check to see that a printer is connected to your computer and that the cables
are snug.
. ensure that the most recent printer driver for your operating system has been
installed, printer drivers are generally available from the printer manufacturer’s
website.
c) Miscellaneous installation problems
. ensure that no other software is running during installation of T4 TimeSaver
such as anti-virus software or programs that start with Windows
. restart your computer to eliminate any potential memory corruption issues
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Appendix D - Province/State Codes
The following abbreviations apply to the Canadian provinces:
NL - Newfoundland
LB - Labrador
PE - Prince Edward Island
NS - Nova Scotia
NB - New Brunswick
QC - Québec
ON - Ontario

MB - Manitoba
SK - Saskatchewan
AB - Alberta
BC - British Columbia
NT - Northwest Territories
NU - Nunavut
YT - Yukon Territories

The following abbreviations apply to the United States:
AL - Alabama
AK - Alaska
AR - Arizona
AR - Arkansas
CA - California
CO - Colorado
CT - Connecticut
DE - Delaware
DC - District of Columbia
FL - Florida
GA - Georgia
HI - Hawaii
ID - Idaho
IL - Illinois
IN - Indiana
IA - Iowa
KS - Kansas
KY - Kentucky
LA - Louisiana
ME - Maine
MD - Maryland
MA - Massachusetts
MI - Michigan
MN - Minnesota
MS - Mississippi
MO - Missouri

MT - Montana
NE - Nebraska
NH - New Hampshire
NJ - New Jersey
NM - New Mexico
NY - New York
NV - Nevada
NC - North Carolina
ND - North Dakota
OH - Ohio
OK - Oklahoma
OR - Oregon
PA - Pennsylvania
RI - Rhode Island
SC - South Carolina
SD - South Dakota
TN - Tennessee
TX - Texas
UT - Utah
VT - Vermont
VA - Virginia
WA - Washington
WV - West Virginia
WI - Wisconsin
WY - Wyoming

Use the code 'ZZ' for instances where none of the above apply.
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Appendix E - Country Codes
ARG - Argentina
AUS - Australia
AUT - Austria
BHS - Bahamas, The
BHR - Bahrain
BGD - Bangladesh
BRB - Barbados
BEL - Belgium
BMU - Bermuda
BRA - Brazil
VGB - British Virgin Islands
CMR - Cameroon
CAN - Canada
CYM - Cayman Islands
CHL - Chile
CHN - China, People's Republic of
COL - Columbia
SUN - Commonwealth of Independent States
CIV - Ivory Coast
CYP - Cyprus
DNK - Denmark
DOM - Dominican Republic
EGY - Egypt
FIN - Finland
FRA - France
DEU - Germany, Federal Republic of
GRC - Greece
GRD - Grenada
GUY - Guyana
HKG - Hong Kong
ISL - Iceland
IND - India
IDN - Indonesia
IRL - Ireland
ISR - Israel
ITA - Italy
JAM - Jamaica
JPN - Japan
KEN - Kenya
KOR - Korea, Republic of (South)
LBN - Lebanon
BLZ - Leeward & Windward Islands & Belize
LBR - Liberia

LIE - Liechtenstein
LUX - Luxembourg
MYS - Malaysia
MLT - Malta
MEX - Mexico
MAR - Morocco
NLD - Netherlands
ANT - Netherlands Antilles
NZL - New Zealand
NGA - Nigeria
NOR - Norway
PAK - Pakistan
PAN - Panama
PNG - Papua New Guinea
PHL - Philippines
POL - Poland
PRT - Portugal
PRI - Puerto Rico
ROM - Romania
SAU - Saudi Arabia
SEN - Senegal
SYC - Seychelles
SLE - Sierra Leone
SGP - Singapore
ZAF - South Africa
ESP - Spain
LKA - Sri Lanka
SWE - Sweden
CHE - Switzerland
TWN - Taiwan (Republic of China)
THA - Thailand
TTO - Trinidad and Tobago
TUN - Tunisia
TUR - Turkey
ARE - United Arab Emirates
GBR - United Kingdom
USA - United States of America
URY - Uruguay
VEN - Venezuela
VIR - Virgin Islands (US)
YUG - Yugoslavia
ZMB – Zambia
OMC - All other countries
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Appendix F - Equivalent Fields
Equivalent fields on T4 and Relevé 1 Slips
The following fields are always identical on a T4 slip and a Relevé 1 slip:
Changing a value on either the T4 or the Relevé 1 will result in the same change
in the corresponding field of the other form.
Box 17 - QPP
Box 18 - EI
Box 20 - RPP contribution
Box 46 - Charitable donations

=
=
=
=

Box B - QPP
Box C - EI
Box D - RPP contribution
Box N - Charitable donations

Equivalent fields on T5 and Relevé 3 Slips
The following fields are always identical on a T5 slip and a Relevé 3 slip:
Changing a value on either the T5 or the Relevé 3 will result in the same change
in the corresponding field of the other form.
*

Box 10 - Actual amount of dividend
Box 13 - Interest from Cdn. sources
Box 14 - Other income from Cdn. sources
sources
Box 15 - Foreign income
Box 16 - Foreign tax paid
Box 17 - Royalties
Box 18 - Cap. Gains Dividends
Box 19 - Acc’d Income: Annuities

*

=
=
=

Box A - Actual amount of dividend
Box D - Interest from Cdn. sources
Box E - Other income from Cdn.

=
=
=
=
=

Box F - Foreign income
Box G - Foreign tax paid
Box H - Royalties
Box I - Cap. Gains Dividends
Box J - Acc’d Income: Annuities

In cases where the recipient is a corporation (i.e. recipient type code is 3), box A
on the RL-3 will be set to zero and box E will contain the sum of Box 10 and Box
14 values from the corresponding T5.
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Appendix G - Filing Requirements
Slip
Type

Payee

Government Copy

Keep for
Records

T4 Slip

Copies 2 & 3
Pre-printed forms or facsimile
on pink or white paper

Copy 1
Pre-printed forms or facsimile
on pink or white paper
Copy 1
Pre-printed forms or facsimile
on pink or white paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms or facsimile
on blue or white paper
Copy 1
Pre-printed forms or facsimile
on blue or white paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Facsimile on blue or white
paper
N/A

Copy 4
Any type of paper

Copy 1
Facsimile on blue or white
paper
Copy 1
Pre-printed forms or facsimile
on blue or white paper
Copy 1
Pre-printed forms or facsimile
on pink or white paper
Copy 1
Pre-printed forms or facsimile
on pink or white paper

Copy 4
Any type of paper

T4
Summary
T4PS Slip

Copies 2 & 3
Facsimile on plain paper

T4PS
Summary
NR4 Slip

Copies 2 & 3
Pre-printed forms or facsimile
on plain paper

NR4
Summary
T4A Slip

Copies 2 & 3
Pre-printed forms or facsimile
on blue or white paper

T4A
Summary
T4A-NR
Slip

Copies 2 & 3
Pre-printed forms or facsimile
on plain paper

T4A-NR
Summary
T4A(P) Slip

T4A(P)
Summary
T4A(RCA)
Slip

Copies 2 & 3
Facsimile on blue or white
paper

Copies 2 & 3
Facsimile on blue or white
paper

T4A(RCA)
Summary
T5 Slip

T5
Summary

Copies 2 & 3
Pre-printed forms or facsimile
on pink or white paper

Copy 2
Any type of paper
Copy 4
Any type of paper
Copy 2
Any type of paper
Copy 4
Any type of paper
Copy 2

Copy 4
Any type of paper
Copy 2
Any type of paper
Copy 4
Any type of paper
Copy 2

Copy 4
Any type of paper
N/A

Copy 2
Any type of paper
Copy 4
Any type of paper
Copy 2
Any type of paper
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Payee
Copies 2 & 3
Pre-printed forms or facsimile
on white paper

Copy 2
Facsimile on white paper

T5018
Summary
RL-1 Slip

RL-1
Summary
RL-2 Slip

RL-2
Summary
RL-3 Slip

RL-3
Summary
RL-17 Slip
RL-17
Summary
RL-25 Slip

RL-25
Summary

Copies 2 & 3
Pre-printed forms or facsimile
on yellow paper

Copies 2 & 3
Pre-printed forms or facsimile
on plain paper

Copies 2 & 3
Pre-printed forms or facsimile
on blue paper

Copies 2 & 3
Pre-printed forms only

Copies 2 & 3
Pre-printed forms or facsimile
on plain paper

Government Copy

Keep for
Records

Copy 1
Facsimile on white paper

Copy 4
Any type of paper

Copy 1
Facsimile on white paper
Copy 1
Pre-printed forms or facsimile
on plain paper
Copies 1 & 2
Pre-printed forms or facsimile
on white paper
Copy 1
Pre-printed forms or facsimile
on yellow paper
Copy 1
Pre-printed forms only
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms only
Copy 1
Pre-printed forms or facsimile
on blue paper
Copy 1
Pre-printed forms only
Copy 1
Pre-printed forms only
Copy 1
Pre-printed forms only
Copy 1
Pre-printed forms or facsimile
on plain paper
Copy 1
Pre-printed forms only

Photocopy
Copy 3
Facsimile on white
paper
Copy 3
Facsimile on white
paper
Copy 4
Any type of paper
Photocopy
Copy 4
Any type of paper
Photocopy
Copy 4 of
facsimile or
photocopy
Photocopy
Photocopy
Photocopy
Copy 4
Any type of paper
Photocopy
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Appendix H - Forms available with T4 TimeSaver
Single Sheet

Facsimile

**Available

Available

Available

T4 Summary

Available

Available

Available

T4PS Slip

Available

Available

N/A

T4PS Summary

Available

Available

N/A

NR4 Slip

Available

Available

Available

NR4 Summary

Available

Available

Available

T4A Slip

Available

Available

Available

T4A Summary

Available

Available

Available

T4A(P) Slip

N/A

Available

Available

T4A(P) Summary

N/A

*N/A

Available

T4A(RCA) Slip

N/A

Available

N/A

Available

Available

N/A

N/A

Available

Available

T4A-NR Summary

Available

Available

Available

T5 Slip

Available

Available

Available

T5 Summary

Available

Available

Available

T5013 Slip

N/A

Available

N/A

T5013 Summary

N/A

Available

N/A

T5018 Slip

Available

Available

N/A

T5018 Summary

Available

Available

N/A

T1204 Slip

N/A

Available

Available

T1204 Summary

N/A

*N/A

Available

RL-1 Slip

Available

Available

Available

RL-1 Summary

Available

*N/A

Available

N/A

Available

Available

Type of Form

T4 Slip

T4A(RCA) Summary
T4A-NR Slip

RL-2 Slip

Magnetic
Media
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Single Sheet

Facsimile

N/A

*N/A

Available

RL-3 Slip

Available

Available

Available

RL-3 Summary

Available

*N/A

Available

RL-15 Slip

N/A

Available

N/A

RL-17 Slip

Available

N/A

N/A

RL-17 Summary

N/A

*N/A

N/A

RL-25 Slip

N/A

Available

Available

*N/A

Available

Type of Form

RL-2 Summary

RL-25 Summary
N/A
*working copy only
**pressure sealed form also available

Magnetic
Media
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Appendix I - Amending, Replacing, and Canceling Slips
Amending and Canceling
CRA and Ministère du Revenu Québec require specific procedures when
amending or canceling slips that have already been submitted. The following
table gives an outline of the requirements for each type of slip.
Amended Slips

Submit new slip
marked
“Amended” at the
top
T4
T4PS
T5

RL-1,
RL-2

RL-3

2

Additional
Requirements

Send letter explaining
the amendment
Yes
Send letter explaining
the amendment
Yes - include filer ID Send letter explaining
number and put “1” the amendment
in Box 21.
Yes - indicate
Send letter explaining
number from upper- the amendment
right hand corner of
original
Yes - put a “1” in
Send photocopy of
box marked “Relevé original clearly
Code “
marked “cancelled”
Yes.

NR4

Yes

T4A-NR

Yes

T5013

Yes

T5018

Yes

Cancelled Slips

Send
Submit Copy of
Amended Original marked
Summary “Cancelled” at
top

Send
Amended
Summary

No

Yes

No

No

Yes

No

If dollar
amount
changed
Yes

Yes (but marked
“Deleted”)

Yes if dollar
amount
changed
Yes

Yes - with
“2” in box
marked
“Code”
Send letter explaining Yes
the amendment
Send letter explaining Yes
the amendment
Send letter explaining Yes
the amendment
Send letter explaining No
the amendment

Yes

Yes

Yes

Yes - with “2”
in box
marked
“Code”
Yes

Yes

Yes

Yes

Yes

Yes

No.

Replacing
In every case, to replace a lost or destroyed slip, reprint and distribute to the
employee as with the original, but DO NOT submit copy 1 to the Tax Centre.
Instead, label it “Duplicate” and keep in your own files.

2

If amendment is because PA is wrong, you don’t have to report the amendment
unless the PA correction is greater than $50 or you are asked to by the employee or
CCRA.
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Appendix J - Headings for Import File
Keywords are used as column headings by the import function to identify the
information in the column. Generally, each keyword is the name of a field in a
TimeSaver table. A special keyword, NULL, can be used to cause the import to
ignore a column.
Text fields are alphanumeric fields with a specified maximum size. If the data to
be imported exceeds the maximum size, the value will be truncated to fit into the
field. If data exceeds the maximum size of a field by more than 30 characters, an
error message will be given and the import process will be halted. Generally, the
alphanumeric fields may contain letters, numbers, spaces and punctuation. In
some cases, they must be in upper case (such as province codes, postal codes
and country codes). In other fields, mixed case is acceptable.
Yes/No fields. Acceptable values for Yes are Y, YES, or -1. Acceptable values
for No are N, NO or 0.
Currency fields are dollar amounts. They should be formatted with a decimal
between the dollars and cents; if there is no decimal, even dollars is assumed.
Do not insert commas as thousands separators. For example, $1,200.50 should
be formatted as 1200.50. The absolute maximum value is 999,999,999.99.
Integer fields are numeric whole numbers from 1 to about 32,000. They must be
entered without decimals or commas; for example, 1234.
Some fields have default values that will be used if the field is not present in the
import file. These are listed in the Comments, Example and Defaults column in
bold print. In addition to those listed below, the province and country codes for
slips are defaulted to the province and country codes of the company information.
Headings for Company Information
Heading

Description

Type,
max. size

NAME1

Line 1 of company name

Text, 35

NAME2

Line 2 of company name

Text,30

CAREOF

Care of line of address

Text,30

ADDRESS1

Line 1 of address

Text,30

ADDRESS2

Line 2 of address

Text,30

CITY

City

Text,28

PROV

Province code

Text,2

Comments,
Examples &
Defaults

ON, QC, BC…
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Heading

Description

Type,
max. size

POSTAL

Postal code (including space)

Text,10

COUNTRY

Country code

Text,3

DEFPROVEMP

Usual province of employment

Text,2

ACCOUNTNO

Business number

Text,15

TAXCENTRE

Taxation centre

Text,13

IDNOQ

Quebec Identification number and file
number (Format 1234567890RS0001)

Text,16

NEQ

Quebec Enterprise number

Text,16

Comments,
Examples &
Defaults

CAN, USA...

Headings for T4 and RL-1 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Employee name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country code

Text, 3

INCOME

Employment income (box 14)

Currency

CPP

CPP contributions (box 16)

Currency

QPP

QPP contributions (box 17, B)

Currency

EI

EI premiums (box 18, C)

Currency

RPP

Reg. Pension plan contr. (box 20, D)

Currency

TAX

Federal income tax deducted (box 22)

Currency

EIEARN

EI insurable earnings (box 24)

Currency

CPPEARN

CPP pensionable earnings (box 26)

Currency

CPPEXEMPT

CPP exempt (box 28)

Yes/No

EIEXEMPT

EI exempt (box 28)

Yes/No

UNION

Union dues (box 44)

Currency

CHARITABLE

Charitable donations (box 46, N)

Currency
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Heading

Description

Type,
max. size

PENSIONNO

RPP/DPSP number (box 50)

Text, 7

PENSION

Pension adjustment (box 52)

Currency

PROVEMP

Province of employment (box 10)

Text, 2

SIN

Social insurance number (box 12)

Text, 9

EMPCODE

Employment code (box 29)

Text, 2

EMPNUM

Employee number, reference number

Text, 20

CPPWEEKS

Weeks eligible for CPP

Numeric,4

52.00, 52.5, etc.

NETPAYOTHER

Other deductions from Net Pay

Currency

For net pay calc.

OTHERCODE1

Other information code #1

Text, 2

OTHERAMT1

Other information amount #1

Currency

OTHERCODE2

Other information code #2

Text, 2

OTHERAMT2

Other information amount #2

Currency

OTHERCODE3

Other information code #3

Text, 2

OTHERAMT3

Other information amount #3

Currency

OTHERCODE4

Other information code #4

Text, 2

OTHERAMT4

Other information amount #4

Currency

OTHERCODE5

Other information code #5

Text, 2

OTHERAMT5

Other information amount #5

Currency

OTHERCODE6

Other information code #6

Text, 2

OTHERAMT6

Other information amount #6

Currency

AMENDED

Amended slip

Yes/No

YOUTHFLAG

Youth hires program

Yes/No

TAXYEAR

Taxation year

Integer,4

Additional headings for RL-1 fields:
INCOMER1

Employment income (box A)

Currency

TAXR1

Quebec income tax deducted (box E)

Currency

UNIONR1

Union dues (box F)

Currency

QPPEARN

QPP pensionable earnings (box G)

Currency

HOUSING

Meals and accommodation (box H)

Currency

AUTOR1

Personal use of auto (box I)

Currency

Comments,
Examples &
Defaults

Current year
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Heading

Description

Type,
max. size

HEALTHR1

Private health insurance (box J)

Currency

TRAVELR1

Travel (box K)

Currency

OTHERTBR1

Other taxable benefits (box L)

Currency

COMMISSIONS

Employment commissions (box M)

Currency

OTHERINC

Other taxable income (box O)

Currency

INSURANCE

Multi-employer insurance (box P)

Currency

DEFERRED

Deferred salary (box Q)

Currency

INDIANINC

Exempt income for an Indian (box R)

Currency

TIPS

Tips received (box S)

Currency

TIPSALLOCATED

Tips allocated (box T)

Currency

PHASEDRETIRE

Phased retirement (box U)

Currency

CODEBOXOR1

Code for Box O

Text, 2

FNOTE1R1

Footnote #1

Text, 30

FNOTE2R1

Footnote #2

Text, 30

FNOTE3R1

Footnote #3

Text, 30

Comments,
Examples &
Defaults

Headings for NR4 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

CAN, USA, etc.

STATUS

Status of slip

Text, 12

Amended, etc.

TAXYEAR

Year (box 10)

Integer,4

2004, 2005, etc.

RECTYPE

Recipient Type (box 11)

Text, 1
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Heading

Description

Type,
max. size

COUNTRYCODE

Country code (box 12)

Text, 3

PAYERID

Payer or remitter Identification Number

Text, 20

SIN

Foreign Social Security or Insurance No.

Text, 20

INCOMECODE1

Income Code (box 14)

Text, 2

CURRENCYCODE1

Currency code (box 15)

Text, 3

INCOME1

Gross Income (box 16)

Currency

TAX1

Non-resident tax withheld (box 17)

Currency

EXEMPTIONCODE1

Exemption code (box 18)

Text, 1

INCOMECODE2

Income Code (box 24)

Text, 2

CURRENCYCODE2

Currency code (box 25)

Text, 3

INCOME2

Gross Income (box 26)

Currency

TAX2

Non-resident tax withheld (box 27)

Currency

EXEMPTIONCODE2

Exemption code (box 28)

Text, 1

Comments,
Examples &
Defaults

Headings for T4PS Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Recipient name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

CAN, USA, etc.

STATUS

Status of slip

Text, 12

Amended, etc.

YEAR

Year

Integer, 4

ACTUAL

Actual amount of dividends (box 30)

Currency

TAXABLE

Taxable amount of dividends (box 31)

Currency

CREDIT

Federal dividend tax credit (box 32)

Currency

CAPGAINS

Capital gains for loses (box 34)

Currency
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Heading

Description

Type,
max. size

OTHER

Other income (box 35)

Currency

FORFEITED

Forfeited due to withdrawal (box 36)

Currency

FOREIGNINCOME

Foreign non-business income (box 37)

Currency

FOREIGNCAPGAINS

Foreign capital gains or losses (box 38)

Currency

FOREIGNTAX

Foreign non-business tax (box 39)

Currency

SIN

Canadian social insurance number (box 12)

Text, 9

Comments,
Examples &
Defaults

Headings for T4A Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Employee name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country code

Text, 3

SIN

Social insurance number (box 12)

Text, 9

YEAR

Year

Integer, 4

RECBN

Recipient Business No. (1 9 digits)

Text, 9

CORPNAME1

Recipient corporation name line 1

Text, 30

CORPNAME2

Recipient corporation name line 2

Text, 30

SUPER

Pension or superannuation (box 16)

Currency

LUMPSUM

Lump-sum payments (box 18)

Currency

SELF

Self-employed commissions (box 20)

Currency

TAX

Income tax deducted (box 22)

Currency

ANNUITIES

Annuities (box 24)

Currency

RETIRING

Eligible retiring allowances (box 26)

Currency

RETIRINGNON

Non-eligible retiring allowances (box 27)

Currency

st
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Heading

Description

Type,
max. size

OTHER

Other income (box 28)

Currency

PATRONAGE

Patronage allocations (box 30)

Currency

PAST

RPP contributions (past service)(box 32)

Currency

PENSION

Pension adjustment (box 34)

Currency

PENSIONNO

Pension plan reg. number (box 36)

Text, 19

RESPACCUM

RESP accumulated income pay’ts (box 40)

Currency

RESPED

RESP educational assist. pay’ts (box 42)

Currency

CHARITABLE

Charitable donations (box 46)

Currency

FNOTECODE

Footnote code (box 38)

Text, 2

RECIPIENTNO

Recipient’s number (box 14)

Text, 12

FNOTE1

Footnote #1

Text, 30

FNOTE2

Footnote #2

Text, 30

FNOTE3

Footnote #3

Text, 30

Comments,
Examples &
Defaults

The following fields are for magnetic media filers only. Consult CRA’s magnetic media specifications
for details. On printed T4A slips, most of this information is included as footnotes. However, the T4
TimeSaver import procedure will NOT create footnotes from this information. To import footnotes that will
appear on printed slips, use the headings FNOTE1, FNOTE2 and FNOTE3 above.
BOX16CODE

Box 16 code

Integer,2

UNREGPEN

Unregistered pension plan

Currency

SIPENSION

Status Indian - pension or superannuation

Currency

BOX18CODE

Box 18 code

Integer, 2

LUMPSUMACC

Lump-sum payments accrued to 12/31/97

Currency

LUMPSUMSI

Status Indian - Lump-sum payments

Currency

LUMPSUMRPP

Lump-sum payments (RPP-not eligible)

Currency

LUMPSUMDPSP

Lump-sum payments (DPSP-not eligible)

Currency

LUMPSUMNONRES

Lump-sum payments (non-resident services)

Currency

LUMPSUMUNREG

Lump-sum payments (unreg’d pension ben.)

Currency

LUMPSUMNOTRANS

Lump-sum payments (not eligible for trans.)

Currency

BOX24CODE

Box 24 code

Integer, 2

DPSPANNUITY

Instalment or annuity payment under DPSP

Currency

0, 9, 13, 14

2, 8, 9, 10, 13, 14

0, 10, 13, 15
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Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

IAACANNUITY

IAAC annuity

Currency

BOX26CODE

Box 26 code

Integer, 2

RETIRINGSI

Status Indian - eligible retiring allowance

Currency

BOX27CODE

Box 27 code

Integer, 2

RETIRINGNONSI

Status Indian - non-eligible retiring allowance

Currency

BOX28CODE

Box 28 code

Integer, 2

OTHERSI

Status Indian - other income

Currency

OTHERDPSP

Instalment or annuity under revoked DPSP

Currency

BOARDSITE

Board and lodging at special work sites

Currency

MEDTRAVEL

Medical travel

Currency

LOANBENEFIT

Loan benefit under subsection 80.4(2)

Currency

MEDBENEFIT

Medical Premium benefit

Currency

SCHOLARSHIP

Scholarships, fellowships, or bursaries

Currency

WAGELOSS

Income from wage loss plans

Currency

DEATHBENEFIT

Death benefits

Currency

DISABILITY

Disability benefits

Currency

GROUPTERMLIFE

Group Term Life Insurance Benefit

Currency

RPPPRE1990

RPP (pre-1990 past service)

Currency

FNOTEDESC

Footnote description area

Text, 60

BOX40CODE

Box 40 code

Integer, 2

RESEARCH

Research Grants

Currency

CHARNO1

Charitable Registration Number 1

Text, 15

CHARNO2

Charitable Registration Number 2

Text, 15

CHARNO3

Charitable Registration Number 3

Text, 15

BOX32CODE

Box 32 code

Integer, 2

see Guide

0, 14

0, 14

see Guide

0, 22

Headings for T4ANR Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Recipient name

Text, 30

Required field
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Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country

Text, 3

USA

YEAR

Taxation Year

Integer, 4

2005

STATUS

Status of slip

Text, 12

Amended, etc.

INCOME

Gross income (box 18)

Currency

TRAVEL

Travel expenses ( box 20)

Currency

TAX

Income tax deducted (box 22)

Currency

REDUCTION

Reduction authorized (box 23)

Text, 1

CITYPROV

City and Province where services tendered

Text, 32

DAYSINCANADA

Number of days recipient was in Canada

Integer

FOREIGNSIN

Foreign Social security number (box 12)

Text, 20

SIN

Canadian social insurance number (box 14)

Text, 9

PROFNAME

Professional name (box 16)

Text, 30

INDUSTRY

Non-resident’s service industry

Text, 4

COUNTRYRES

Country of Residence

Text, 3

USA

1

Max. of 366

Headings for T4A(P) Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Employee name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country code

Text, 3

Appendices
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Heading

Description

Type,
max. size

NUMOFMONTH

Number of month (box 21)

Integer, 2

EFFECTIVEDATE

Effective date (box 13)

Date,
mmm dd,,
yyyy

TAXABLECPP

Taxable CPP benefits (box 20)

Currency

INCOMETAX

Income tax deducted (box 22)

Currency

RETIREMENT

Retirement benefit (box 14)

Currency

SURVIVOR

Survivor benefit (box 15)

Currency

DISABILITY

Disability benefit (box 16)

Currency

CHILD

Child benefit (box 17)

Currency

DEATH

Death benefit (box 18)

Currency

BENEFITNUM

Benefit number

Text, 20

SIN

Social insurance number (box 12)

Text, 9

Comments,
Examples &
Defaults

Aug 03, 2005

Headings for T4A(RCA) Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME

Employee name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country code

Text, 3

REFUNDEMPLOYER

Refund of employer contributions (box 12)

Currency

REFUNDEMPLOYEE

Refund of employee contributions (box 14)

Currency

DISTRIBUTIONS

Distributions (box 16)

Currency

SELLINGPRICE

Selling price of an interest in RCA(box 18)

Currency

OTHER

Other amounts (box 20)

Currency

INCOMETAX

Income tax deducted (box 22)

Currency

SIN

Social insurance number (box 24)

Text, 9
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Headings for T5 and RL-3 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country code

Text, 3

TAXYEAR

Taxation year

Integer,4

ACTUAL

Actual amount of dividends (box 10)

Currency

TAXABLE

Taxable amount of dividends (box 11)

Currency

CREDIT

Federal dividend tax credit (box 12)

Currency

INTEREST

Interest from Cdn sources (box 13, D)

Currency

OTHER

Other income from Cdn sources (box 14)

Currency

FORINC

Foreign income (box 15, F)

Currency

FORTAX

Foreign tax paid (box 16, G)

Currency

ROYALTIES

Royalties from Cdn sources (box 17, H)

Currency

CAPGAINS

Capital gains dividends (box 18, I)

Currency

PBCAPGAINS

Pre-Budget cap. gains dividends (box 40)

Currency

ACCRUED

Accrued income: Annuities (box 19, J)

Currency

RESOURCE

Resource allowance deduction (box 20)

Currency

REPORTCODE

Report code (box 21)

Text, 1

SIN

Recipient identification number (box 22)

Text, 15

RECTYPE

Recipient type (box 23)

Text, 1

CURRENCY

Foreign currency code (box 27)

Text, 3

TRANSIT

Transit (box 28)

Text, 10

ACCOUNTNO

Recipient account number (box 29)

Text, 16

Current year

0

1

Appendices
Heading

12-25
Description

Type,
max. size

Comments,
Examples &
Defaults

Additional Heading for RL-3 fields:
ACTUALR3

Actual amount of dividends (box A)

Currency

TAXABLER3

Taxable amount of dividends (box B)

Currency

CREDITR3

Dividend tax credit (box C)

Currency

OTHERR3

Other income from Cdn Sources (box E)

Currency

NEEDR3

Recipient needs RL-3

Yes/No

ACCOUNTNOR3

Other ID/Recipient Number RL-3

Text, 16

Headings for T5013 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

CAN, USA, etc.

STATUS

Status of slip

Text, 12

Amended, etc.

COUNTRYCODE

Country code (box 7)

Text, 3

CAN, USA, etc.

MEMBERCODE

Member code (box 8)

Text, 1

UNITSOWNED

Partnership units held (box 9)

Numeric

RECTYPE

Recipient code (box 11)

Text, 1

PARTNERID

Recipient’s ID (box 12)

Text, 16

CEERENUNCIATION

Cdn. Exploration Expense, Renunciation

Currency

CEEADJUSTMENT

Cdn. Exploration Expense, Adjustment

Currency

CEETAXCREDITBC

Box 141

Currency

CEETAXCREDITSK

Box 143

Currency

CEETAXCREDITMB

Box 144

Currency

4 decimals
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Heading

Description

Type,
max. size

CEETAXCREDITON

Box 145

Currency

CEEASSISTANCE

Cdn. Exploration Expense, Assistance

Currency

CDERENUNCIATION

Cdn. Development Expense, Renunciation

Currency

CDEADJUSTMENT

Cdn. Development Expense, Adjustment

Currency

CDEASSISTANCE

Cdn. Development Expense, Assistance

Currency

DETAILS

Details

Text

Comments,
Examples &
Defaults

Up to 1000 char.

Note:
The Details box of the T5013 slip is a free-format field where you may enter details about the various
boxes on the slip. When you create a text file of T5013 data to be imported into T4 TimeSaver, you can
insert a tilde (~) in the text to cause a line break. For example, to create the following table:
Provincial allocation:
BC: 18.5%
AB:
12.0%
QC:
12.3%
(etc)
you would enter the following in the Details column of your import file:
Provincial allocation:~BC

18.5%~AB:

12.0%~QC:

12.3%

Headings for boxes 18-45 and boxes 53-58 are in the following format, where nn is the box number:
BOXnn

Box nn

Currency

Additional Headings for T5015 fields:
CAPITALSTART

Capital account start of period

Currency

CAPITALCONTR

Capital contribution during period

Currency

INCOMEALLOC

Income allocated during period

Currency

DRAWINGS

Drawings

Currency

CAPITALEND

Capital account end of period

Currency

Headings for T5018 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

STATUS

Status of slip

Text, 12

Amended, etc.

NAME

Recipient name

Text, 30

Required field

ADDRESS1

Address line 1

Text, 30

Appendices
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Heading

Description

Type,
max. size

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

PAYMENTS

Construction subcontractor payments (box 22)

Currency

SIN

Recipient’s ID number (BN or SIN) (box 24)

Text, 15

Comments,
Examples &
Defaults

CAN, USA, etc.

Headings for T1204 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

STATUS

Status of slip

Text, 12

Amended, etc.

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

POSTAL

Postal code (including space)

Text, 10

PROV

Province code

Text, 2

COUNTRY

Country, in address

Text, 3

YEAR

Year

Integer, 4

RECTYPE

Recipient type (box 23)

Text, 1

SERVICEPAYMENTS

Service payments (box 82)

Currency

MIXEDPAYMENTS

Mixed services payments (box 84)

Currency

SIN

Social insurance number (box 12)

Text, 9

BN

Business number (box 61)

Text, 15

PARTNERSHIPID

Partnership’s filer ID (box 86)

Text, 9

LASTNAME

Sole proprietor’s last name

Text, 20

FIRSTNAME

Sole proprietor’s first name

Text, 12

INITIAL

Sole proprietor’s initial

Text, 1

CAN, USA, etc.

1, 3, or 4
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Headings for RL-2 Slips
NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

SOURCE1

Source of income

Text, 6

BENEFICIARYNUM

Employer assigned number

Text, 20

ANNUITY

Life annuity payments amount

Currency

Box A

BENEFIT

RRSP, RRIF, DPSP benefit amount

Currency

Box B

OTHERPAYMENT

Other Payment amount

Currency

Box C

REFUNDRRSPSPOUSE

Refunded RRSP amounts

Currency

Box D

DEATHBENEFIT

Value of benefit at time of death

Currency

Box E

REFUNDRRSPUNDEDUCTED

Amount of refunded excess RRSP

Currency

Box F

REVOCATION

Value of benefit before amendment

Currency

Box G

OTHERINCOME

All other income

Currency

Box H

DEDUCTION

Amount giving entitlement to deduction

Currency

Box I

TAX

Amount of Quebec tax held at source

Currency

Box J

INCOMEAFTERDEATH

Income earned after death amount

Currency

Box K

LIFELONGLEARNIN
G

Life Long Learning Plan amount

Currency

Box L

TAXPAIDAMOUNT

Tax paid amount

Currency

Box M

SIN

Spouses social insurance number

Text, 9

SIN2

Spouses social insurance number

Text, 9

Box N

CAN, USA, etc.

Headings for RL-15 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME1

Recipient name line 1

Text, 30

Required field

Appendices
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Heading

Description

Type,
max. size

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

PROV

Province code

Text, 2

POSTAL

Postal code (including space)

Text, 10

COUNTRY

Country, in address

Text, 3

CAN, USA, etc.

Text, 1

0=original,
1=amended

REPORTCODE

Report code (code du relevé)

MEMBERCODE

Member code (box 39)

Text, 1

UNITSOWNED

Partnership units held (box 36)

Numeric

RECTYPE

Recipient code (box 40)

Text, 1

PARTNERID

Recipient’s ID (SIN, etc.)

Text, 16

Comments,
Examples &
Defaults

4 decimals

Headings for boxes 1-34 and 41-66 are in the following format, where nn is the box number, X is a letter
following the number (for example, Box 20A) and yy is the sub box number for boxes 34 and 66.
BOXnnX

Box nnX

Currency

BOXnn_yy

Box 34-27, 34-28, 66-60, 66-61, etc.

Currency

DETAILS

Details (see note below)

Text

Up to 1000 char.

Note:
The Details box of the RL-15 slip is a free-format field where you may enter details about the various
boxes on the slip. When you create a text file of T5013 data to be imported into T4 TimeSaver, you can
insert a tilde (~) in the text to cause a line break. For example, to create the following table:
Provincial allocation:
BC: 18.5%
AB:
12.0%
QC:
12.3%
(etc)
you would enter the following in the Details column of your import file:
Provincial allocation:~BC

18.5%~AB:

12.0%~QC:

12.3%
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Headings for RL-17 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

STATUS

Status of slip

Text, 12

Amended, etc.

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

POSTAL

Postal code (including space)

Text, 10

PROV

Province code

Text, 2

COUNTRY

Country, in address

Text, 3

YEAR

Year

Text, 1

DEDUCTION

Total deductions (box A)

Currency

INCOMEYEAR

Total employment revenue (box B)

Currency

INCOMESTAY

Total income for stay (box C)

Currency

ALLOWANCEYEAR

Allowance in year (box D)

Currency

ALLOWANCESTAY

Allowance for stay (box E)

Currency

DAYSOUTSIDE

Days outside Canada (box F)

Integer

PERIODSOUTSIDE

Number of 30 day periods (box G)

Integer

DATEDEPARTURE

Departure date from Canada (box H)

Date

DATERETURN

Return date to Canada (box I)

Date

FOREIGNCOUNTRY

Name of foreign country (box J)

Text, 20

SIN

Social insurance number

Text, 9

REFERENCENUMBER

Employer reference number

Text, 15

CAN, USA, etc.

Headings for RL-25 Slips
Heading

Description

Type,
max. size

Comments,
Examples &
Defaults

NAME1

Recipient name line 1

Text, 30

Required field

NAME2

Recipient name line 2

Text, 30

Appendices
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Heading

Description

Type,
max. size

ADDRESS1

Address line 1

Text, 30

ADDRESS2

Address line 2

Text, 30

CITY

City

Text, 28

POSTAL

Postal code (including space)

Text, 10

PROV

Province code

Text, 2

COUNTRY

Country, in address

Text, 3

BENEFICIARYNUM

Employer assigned number

Text, 20

TRANSIT

Bank transit number

Text, 10

RECTYPE

Recipient type (box 23)

Text, 1

SECONDNAMELAST

Last name of 2

SECONDNAMEFIRST

First name of 2

SIN2

SIN of 2

ACTUALDIVIDENDS

Dividend amount

Currency

Box A

CAPGAINS

Total net Capital Gains

Currency

Box B

CAPGAINSEXEMPTION

Farm or small business capital gains

Currency

Box C

OTHER

QPP and other amounts

Currency

Box D

CANCELLED

Amounts cancelled

Currency

Box E

TAXABLEDIVIDENDS

Taxable amount of dividends

Currency

Box F

TAXCREDIT

Amount of dividend tax credit

Currency

Box G

FOREIGNTAX

Income tax paid to a foreign government

Currency

Box H

QUEBECTAX

Quebec income tax withheld

Currency

Box I

NAMESPRINCIPAL

Principal person who established trust deed

Text, 25

SIN

Beneficiary SIN

Text, 9

nd

nd

account holder if joint

Text, 30

nd

account holder if joint

Text, 30

account holder if joint account

Comments,
Examples &
Defaults

CAN, USA, etc.

1

Text, 9
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merge................................................................ 11-1
refresh ................................................................ 5-5
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transfer ............................................................. 11-1
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default values ..................................................... 4-2

editing .................................................................5-1
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printing ...............................................................9-8
Computer
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Country Codes .......................................................12-7
CPP Adjustment Options
default .................................................................4-2
do not adjust .......................................................6-5
setting..........................................5-2, 5-5, 7-2, 12-3
CPP Pensionable Weeks
default value .......................................................4-2
setting..................................................................6-5
setting maximum ................................................7-3
CPP/QPP Exemption ..............................................6-5
Create
company...................................................... 2-6, 5-1
database ..............................................................3-1
slips ............................................................. 2-6, 6-1
Currency Code .......................................................6-18
Data Backup ..........................................................12-1
Data Entry
NR4 slips.............................................................6-7
short-cuts ............................................................4-1
slips .....................................................................6-2
status ......................................................... 8-2, 9-10
T4 slips................................................................6-4
Databases
closing.................................................................3-2
converting from last year .................................11-4
creating ...............................................................3-1
deleting ...............................................................3-2
finding ................................................................3-3
opening ...............................................................3-2
refresh from ........................................................5-5
renaming ............................................................3-2
repair.................................................................11-2
unlocking companies .........................................5-5
Defaults
magnetic media settings .....................................4-3
new company ......................................................4-2
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Edit
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Exempt
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Filing Requirements ............................................. 12-9
Filters
using ..........................................................9-9, 10-5
Find
company ......................................................2-6, 5-3
database.............................................................. 3-3
slips..............................................................2-7, 6-2
Font Selection ......................................................... 9-2
Footnotes
RL-1.................................................................. 6-28
T4A ................................................................... 6-11
T4s and RL-1s .................................................. 6-27
French T4s
printing............................................................... 9-2
Function Keys ......................................................... 2-4
Hardware Requirements ......................................... 1-2
Help ......................................................................... 2-8
send database ..................................................... 2-8
send email .......................................................... 2-8
Icons ........................................................................ 2-6
Import .................................................................... 11-5
Import from magnetic media ................................ 11-8
Import from text .................................................... 11-5
errors ................................................................ 12-4
headings ......................................................... 12-14
company information ............................... 12-14
NR4 slips ................................................... 12-17
RL-15 slips ................................................ 12-28
RL-17 slips ................................................ 12-30
T1204 slips ................................................ 12-27
T4/RL-1 slips............................................. 12-15
T4A slips ................................................... 12-19
T4A(RCA) slips..............................12-22, 12-23
T4ANR slips .............................................. 12-21
T4PS slips ................................................. 12-18
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T5/RL-3 slips .............................................12-24
T5013 slips ................................................12-25
T5018 slips ................................................12-26
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printing ...............................................................9-2
removing ..................................................... 5-5, 6-1
Income Code ............................................................6-8
Input
conventions.........................................................2-7
Installation...............................................................2-1
network administrator........................................2-2
single user...........................................................2-2
updates..............................................................12-4
Internet
filing..................................................................10-7
License Agreement ..................................................1-3
Magnetic Media
default settings....................................................4-3
status .................................................................9-10
transmitter numbers .........................................10-4
Magnetic Media Filing
federal ...............................................................10-1
making corrections...........................................10-2
Québec ..............................................................10-3
Main T4 TimeSaver Window ..................................2-4
Member Code.........................................................6-21
Merge companies...................................................11-1
Net Pay Calculation.................................................6-6
RL-1 ..................................................................6-28
Network administrator installation.........................2-2
New
company defaults................................................4-2
NR4
slip data entry .....................................................6-7
summary .............................................................8-4
Options
adjustment default..............................................4-2
CPP adjustment..................................................4-2
do not adjust CPP...............................................6-5
do not adjust EI ..................................................6-5
do not adjust QPP ..............................................6-5
EI adjustment .....................................................4-2
pensionable weeks ..............................................4-2
QPP adjustment..................................................4-2
user setup............................................................4-1
Other Income
T4 ........................................................................6-5
Other problems ......................................................12-5
Over-remittance .......................................................7-3
Override
calculated fields..................................................6-2
Overriding Calculated Values .................................8-1
Paper source ............................................................9-2
Passwords.................................................................2-3
Pre-printed Forms
printing ...............................................................9-2
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